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Safety

This chapter includes:

®  ELECLICAL SATELY et s s bbbt bbb e be bbb s bbb 12
®  OPETALIONAL SAFELY w.oorveerrereeeries sttt s s sssssssss s sssssbsss st b s s s s s s s s s s s s s s ssss st ssss s ssnsssns 14
®  MAINEENANCE SAFELY ..oorreeeeee ettt sessse s s ss s s st s s s s s s s nnsnns 16
©  PLINEEE SYMIDOLS oottt s s bbb s b e s bbb A e bbb e bbb s bt b 17

e  Environmental, Health, and Safety Contact Information

Your printer and the recommended supplies have been designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued safe operation of your Xerox
printer.
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Safety

Electrical Safety

This section includes:

GENETAL GUIAELINES ..ottt et ssse s s s s sssss s sssssss s s s ssssessssssssassssasssassssesssnssssesassssssesssssssnees 12
POWET COTG..oueneieeieeieeeee ettt sssse st s s s s s ettt b e 13
EMEIGENCY TUIN Off oottt sssss st s sssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssnssssssssnssssssssnnssssases 13
LOSEE SAFOLY oot ssssse s ssssssssssess s sssssssssssssssessss e ss s s s ssasssssbs RS Ss eSS bses 13

General Guidelines

/A WARNINGS:

e Do not push objects into slots or openings on the printer. Touching a voltage point or shorting
out a part could result in fire or electric shock.

e Do not remove the covers or guards that are fastened with screws unless you are installing
optional equipment and are instructed to do so. Turn off the printer when performing these

installations. Disconnect the power cord when removing covers and guards for installing optional

equipment. Except for user-installable options, there are no parts that you can maintain or
service behind these covers.

The following are hazards to your safety:

The power cord is damaged or frayed.

Liquid is spilled into the printer.

The printer is exposed to water.

The printer emits smoke, or the surface is unusually hot.

The printer emits unusual noise or odors.

The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1.
2.
3.

12

Turn off the printer immediately.
Disconnect the power cord from the electrical outlet.
Call an authorized service representative.

Xerox® WorkCentre® 3655 Multifunction Printer
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Safety

Power Cord

Use the power cord supplied with your printer.

Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check
the outlet.

Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a
ground connection terminal.

& WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded properly.

Electrical products can be hazardous if misused.

Only use an extension cord or power strip designed to handle the electrical current capacity of the
printer.

Verify that the printer is plugged into an outlet that is providing the correct voltage and power.
Review the electrical specification of the printer with an electrician if necessary.

Do not place the printer in an area where people can step on the power cord.

Do not place objects on the power cord.

Do not plug or unplug the power cord while the power switch is in the On position.

If the power cord becomes frayed or worn, replace it.

To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

Emergency Turn Off

If any of the following conditions occur, turn off the printer immediately and disconnect the power cord
from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if:

The equipment emits unusual odors or makes unusual noises.

The power cable is damaged or frayed.

A wall panel circuit breaker, fuse, or other safety device has been tripped.
Liquid is spilled into the printer.

The printer is exposed to water.

Any part of the printer is damaged.

Laser Safety

This printer complies with laser product performance standards set by governmental, national, and
international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous
light because the beam is totally enclosed during all modes of customer operation and maintenance.

WARNING: Use of controls, adjustments, or performance of procedures other than those specified in
this manual can result in hazardous radiation exposure.

Xerox® WorkCentre® 3655 Multifunction Printer 13
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Safety

Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your
printer.

Operational Guidelines

e Do not remove any paper trays while the printer is printing.

e Do not open the doors when the printer is printing.

e Do not move the printer when it is printing.

e  Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

e  Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove
the protective covers.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.

Printer Location
e  Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight.
To find the weight for your printer configuration, see Physical Specifications on page 194.

e Do not block or cover the slots or openings on the printer. These openings are provided for
ventilation and to prevent overheating of the printer.

e  Place the printer in an area where there is adequate space for operation and servicing.

e  Place the printer in a dust-free area.

e Do not store or operate the printer in an extremely hot, cold, or humid environment.

e Do not place the printer near a heat source.

e Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.

e Do not place the printer where it is directly exposed to the cold air flow from an air conditioning
system.

e Do not place the printer in locations susceptible to vibrations.
e  For optimum performance, use the printer at the elevations specified in Elevation on page 197.

14 Xerox® WorkCentre® 3655 Multifunction Printer
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Safety

Printer Supplies

e Use the supplies designed for your printer. The use of unsuitable materials can cause poor
performance and a possible safety hazard.

e Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.

e Store all consumables in accordance with the instructions given on the package or container.

e  Keep all consumables away from the reach of children.

e  Never throw toner, print/drum cartridges, or toner containers into an open flame.

e  When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase
the risk of skin or eye contact.

& CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement,
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary
outside these areas. Please contact your Xerox representative for details.

Xerox® WorkCentre® 3655 Multifunction Printer 15
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Safety

Maintenance Safety

e Do not attempt any maintenance procedure that is not specifically described in the documentation
supplied with your printer.

e Do not use aerosol cleaners. Clean with a dry lint-free cloth only.

e Do not burn any consumables or routine maintenance items. For information on Xerox supplies
recycling programs, go to www.xerox.com/gwa.

16 Xerox® WorkCentre® 3655 Multifunction Printer
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Safety

Printer Symbols

Symbol Description

Warning:
A Indicates a hazard which, if not avoided, could result in death or serious injury.

Caution:
Indicates a mandatory action to take in order to avoid damage to the property.

Hot surface on or in the printer. Use caution to avoid personal injury.

Do not burn the item.

Do not expose the imaging unit to light for more than 10 minutes.

Do not expose the imaging unit to direct sunlight.

Do not touch the part or area of the printer.

Warning:
A Wait for the printer to cool for the specified time before touching the fuser.

175°C
> 347°F
D) 00:40%

This item can be recycled. For details, see Recycling and Disposal on page 215.

Xerox® WorkCentre® 3655 Multifunction Printer 17
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Safety

Environmental, Health, and Safety Contact
Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies,
contact the following customer help lines:

United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)
Europe: +441707 353 434

For product safety information in the United States and Canada, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/environment_europe.

18 Xerox® WorkCentre® 3655 Multifunction Printer
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Features

Parts of the Printer

This section includes:
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O INTEEINIAL PAIES ettt esse s sas s ssss s sasssssas s sassassasssssssasssssasassassassassasassassnssassnsassassassassssassassassnsnssnssns 22
O CONETOL PON@Ltetteee et s e e e eastee s aee st s ts s aee st s st s st s s easastasassasassasasseensastasassasasaeensastasastens 23

Front View

1. Tray 1 6. Duplex Automatic Document Feeder

2. Bypass Tray 7. Staple Cartridge Door

3. Front Door 8. Output Tray

4, Output Tray Paper Stop 9. Front Door Handle

5. Control Panel 10.Optional 550-Sheet Feeders (Trays 2-4)

20 Xerox® WorkCentre® 3655 Multifunction Printer
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Features

Rear View
8 z
7
6
5
4
3 I ﬂ\
2 N
#
\ 12 11
1 Q) 2
0%
1. USB Type B Port 7. Transfer Roller
2. Ethernet Connector 8. Fuser
3. USB Type A Port 9. USB Type A Port
4. USB Type A Port 10.Power Switch
5. Rear Door 11.Power Connector
6. Duplex Unit 12.Fax Line Connector

X model only
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Features

Internal Parts

1. Output Tray Paper Stop 5. Duplex Automatic Document Feeder
2. Front Door 6. Document Cover
3. Smart Kit Drum Cartridge 7. Document Glass
4. Toner Cartridge 8. Staple Cartridge

22 Xerox® WorkCentre® 3655 Multifunction Printer
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Features

Control Panel

The control panel consists of a touch screen and buttons you press to control the functions available on
the printer. The control panel:

e Displays the current operating status of the printer.

e  Provides access to print features.

e  Provides access to reference materials.

e  Provides access to Tools and Setup menus.

e  Provides access to Troubleshooting menus and videos.

e  Prompts you to load paper, replace supplies, and clear jams.
e Displays errors and warnings.
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Features

Item Name Description
1 'l;ci)sl:;iZyScreen The screen displays information, and provides access to printer functions.
2 Services Home This button provides access to printer features, such as copy, scan, and fax, on the touch
Button screen.
. This button returns to the active service from the Job Status or Machine Status screens,
3 Services Button ;
or to a preset service.
4 Job Status Button This button displays lists of all active, secure, or completed jobs on the touch screen.
5 gAuatiglnne Status This button displays the status of the printer on the touch screen.
6 Alphanumeric The keypad enters alphanumeric information.
Keypad
C (clear) Button This button deletes numeric values or the last digit entered using the alphanumeric keys.
Dial Pause Button This button inserts a pause in a telephone number when it transmits a fax.
Interrupt Button This button pauses the current job to run a more urgent print, copy, or fax job.
10 Start Button This button starts the selected copy, scan, fax, or Print From job, such as Print from USB.
1 Stop Button This buttgn stops.the current job temporarily. To cancel or resume your job, follow the
onscreen instructions.
12 Clear All Button This button clears previous and changed settings for the current selection. To reset all
features to their default settings and clear existing scans, press this button twice.
13 Power Button This button powers up or powers down the printer.
14 Language Button This button changes the touch screen language and keyboard settings.
15 Power Saver button | This button enters and exits the low-power mode.
16 Help Button This button displays information about the current selection on the touch screen.
17 Log In/Out Button This button provides access to password-protected features.
24 Xerox® WorkCentre® 3655 Multifunction Printer
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Features

Power Saver Mode

You can set the time the printer spends idle in ready mode before the printer transitions to a lower
power level.

Setting the Power Saver Timer

1. At the printer control panel, press the Machine Status button, then touch the Tools tab.
2. Touch General.

3. If needed, log in as administrator. For details, see the System Administrator Guide at
www.xerox.com/office/WC3655docs.

4. Touch Energy Saver.

5.  Touch an option;
— Intelligent Ready causes the printer to wake and sleep based on previous usage patterns.
— Job Activated sets the printer to wake when it receives a job.
—  Scheduled causes the printer to wake and sleep according to a schedule you specify.

6. If you selected Job Activated, to change the default low-power and sleep timeout periods, touch
Energy Saver Timers.

7. If you selected Scheduled, touch an option.
— Energy Saver Timers: This option changes the default low-power and sleep timeout periods.

—  Scheduled Settings: This option selects the times that you want the printer to wake or sleep for
each day of the week.

8. Touch Save.
Exiting Power Saver Mode

The printer exits Power Saver mode automatically when it receives data from a connected device.

To exit Power Saver mode manually, on the control panel, press the Power Saver button.

Xerox® WorkCentre® 3655 Multifunction Printer 25
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Features

Information Pages

Your printer has a printable set of information pages stored on its internal hard drive. Information pages
include configuration and font information, demonstration pages, and more.

1. At the printer control panel, press the Machine Status button.

2. Onthe Machine Information tab, touch Information Pages, then touch the desired information
page.
3. Touch Print.

Note: Information pages can also be printed from CentreWare Internet Services.

Printing the Configuration Report

1. At the printer control panel, press the Machine Status button.
2. On the Machine Information tab, touch Information Pages>Configuration Report>Print.
3. Touch Close after the report prints.
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Features

Administrative Features

CentreWare Internet Services

CentreWare Internet Services is the administration and configuration software installed on the
embedded Web server in the printer. It allows you to configure and administer the printer from a Web
browser.

CentreWare Internet Services requires:

e  ATCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux
environments.

e TCP/IP and HTTP enabled in the printer.
e A network-connected computer with a Web browser that supports JavaScript.

For details, see the Help in CentreWare Internet Services or the System Administrator Guide.

Accessing CentreWare Internet Services

At your computer, open a Web browser, in the address field, type the IP address of the printer, then press
Enter or Return.
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Finding the IP Address of the Printer

To install the print drivers for a network-connected printer, you need the IP address of your printer. You
also need the IP address to access the settings of your printer through CentreWare Internet Services.

You can view the IP address of your printer on the control panel or on the Configuration Report. On the
Configuration Report, IP address information is located in the Connectivity Protocols section.

To view the IP address of the printer on the control panel:

1.
2.

At the printer control panel, press the Machine Status button.
Touch the Machine Information tab.

—  If the system administrator has set the Display Network Settings to show the IP address, it
appears in the center panel.

—  If the IP address is not displayed, print the Configuration Report or contact your system
administrator.

To print a configuration report:

1.
2.
3.

28

At the printer control panel, press the Machine Status button.

On the Machine Information tab, touch Information Pages>Configuration Report>Print.

Touch Close after the report prints.

Note: After the printer has been on for two minutes, print the Configuration Report. The TCP/IP
address appears in the Network section of the page. If the IP address listed on the page is 0.0.0.0,

the printer needs more time to acquire an IP address from the DHCP server. Wait two minutes, then
print the Configuration Report again.
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More Information

You can obtain more information about your printer from these sources:

Resource Location

Installation Guide

Packaged with the printer.

Features

Other documentation for your printer

www.xerox.com/office/WC3655docs

Recommended Media List

United States: www.xerox.com/paper
European Union: www.xerox.com/europaper

Technical support information for your printer;
including online technical support, Online Support
Assistant, and driver downloads.

www.xerox.com/office/WC3655support

Information Pages

Print from the control panel, or from CentreWare
Internet Services, click Status>Information Pages.

CentreWare Internet Services documentation

In CentreWare Internet Services, click Help.

Order supplies for your printer

www.xerox.com/office/WC3655supplies

A resource for tools and information, including
interactive tutorials, printing templates, helpful tips,
and customized features to meet your individual
needs.

www.xerox.com/office/businessresourcecenter

Local sales and support center

www.xerox.com/office/worldcontacts

Printer registration

www.xerox.com/office/register

® N: .
Xerox~ Direct online store

www.direct.xerox.com/
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Installation and Setup

This chapter includes:

Installation and Setup Overview

Selecting a Location for the Printer
Connecting the Printer

Configuring Network Settings

Enabling the Printer for Scanning
Installing the Software

Installing the Printer as a Web Service on Devices....

See also:

Installation Guide packaged with your printer.

Online Support Assistant at www.xerox.com/office/WC3655support
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Installation and Setup

Installation and Setup Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure
the initial settings of the printer, then install the driver software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect over a network using
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different
connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet
connection because it is typically faster than a USB connection, and it provides access to CentreWare
Internet Services.

Note: If the Software and Documentation disc is not available, you can download the latest drivers
from www.xerox.com/office/WC3655drivers.

See also:

Selecting a Location for the Printer on page 33
Choosing a Connection Method on page 34
Connecting the Printer on page 34
Configuring Network Settings on page 38
Installing the Software on page 40
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Selecting a Location for the Printer

1. Select a dust-free area with temperatures from 5-32°C (41-90°F), and relative humidity 15-85%.

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can
cause condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the
printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the
weight for your printer configuration, see Physical Specifications on page 194. Select a location with
adequate clearance to access supplies and to provide proper ventilation. To find the clearance
requirements for your printer, see Clearance Requirements on page 195.

3. After positioning the printer, you are ready to connect it to the power source and computer or
network.
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Connecting the Printer

This section includes:

Selecting @ CoNNECLION MELNOM ...t ssssssssssss s ssss s sassssssesssssssnes 34
Physically Connecting the Printer to the NetWOTK ... 35
Connecting to a COMPUEET USING USB ... eereeeiseiseissisessssssssssssssssssssssssssssssssssssssssssssssssssssssssesssssses 36
Connecting tO A TElEPNONE LNt sesss s sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnes 36
Turning the Printer ON AN Off ...ttt sssssas s ssssssass s sasss s sassssannes 36

Selecting a Connection Method

The printer can be connected to your computer using a USB cable or an Ethernet cable. The method you
select depends on how your computer is connected to the network. A USB connection is a direct
connection and is the easiest to set up. An Ethernet connection is used for networking. If you are using a
network connection, it is important to understand how your computer is connected to the network. For
details, see About TCP/IP and IP Addresses on page 38.

34

Notes:

e Not all options listed are supported on all printers. Some options apply only to a specific printer
model, configuration, operating system, or driver type.

e  Hardware and cabling requirements vary for the different connection methods. Routers,
network hubs, network switches, modems, Ethernet cables, and USB cables are not included
with your printer and must be purchased separately.

Network: If your computer is connected to an office network or home network, use an Ethernet
cable to connect the printer to the network. You cannot connect the printer directly to the computer.
It must be connected through a router or hub. An Ethernet network can be used for one or more
computers and supports many printers and systems simultaneously. Ethernet connection is typically
faster than USB and allows you direct access to the settings of the printer using CentreWare
Internet Services.

Wireless Network: If your computer includes a wireless router or wireless access point, you can
connect the printer to the network with a wireless connection. A wireless network connection
provides the same access and services as a wired connection provides. A wireless network
connection is typically faster than USB and allows direct access to the setting of the printer using
CentreWare Internet Services.

USB: If you connect the printer to one computer and do not have a network, use a USB connection.
A USB connection offers fast data speeds, but typically not as fast as an Ethernet connection. In
addition, a USB connection does not provide access to CentreWare Internet Services.

Telephone: To send and receive faxes, the multifunction printer must be connected to a dedicated
telephone line.
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Physically Connecting the Printer to the Network

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is
used for one or more computers and supports many printers and systems simultaneously. An Ethernet
connection provides direct access to printer settings using CentreWare Internet Services.

To connect the printer:
1. Connect the power cord to the printer, and plug the cord into an electrical outlet.

2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the printer.
Connect the other end of the Ethernet cable to a correctly configured network port on a hub or
router.

3. Turn on the printer.

Note: For details on configuring wireless network settings, see the System Administrator Guide at
www.xerox.com/office/WC3655docs.

Finding the IP Address of the Printer

To install the print drivers for a network-connected printer, you need the IP address of your printer. You
also need the IP address to access the settings of your printer through CentreWare Internet Services.

You can view the IP address of your printer on the control panel or on the Configuration Report. On the
Configuration Report, IP address information is located in the Connectivity Protocols section.

To view the IP address of the printer on the control panel:
1. At the printer control panel, press the Machine Status button.
2. Touch the Machine Information tab.

—  If the system administrator has set the Display Network Settings to show the IP address, it
appears in the center panel.

— If the IP address is not displayed, print the Configuration Report or contact your system
administrator.

To print a configuration report:

1. At the printer control panel, press the Machine Status button.

2. Onthe Machine Information tab, touch Information Pages>Configuration Report>Print.

3. Touch Close after the report prints.
Note: After the printer has been on for two minutes, print the Configuration Report. The TCP/IP
address appears in the Network section of the page. If the IP address listed on the page is 0.0.0.0,

the printer needs more time to acquire an IP address from the DHCP server. Wait two minutes, then
print the Configuration Report again.
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Connecting to a Computer Using USB

To use USB, you must have Windows 7, Windows Server 2003, and later, or Macintosh OS X version 10.7
and later.

To connect the printer to the computer using a USB cable:

1. Ensure that the printer is turned off.

Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the back of the printer.
Attach the power cord and then plug in the printer and turn it on.

Connect the A end of the USB cable to the USB Port on the computer.

When the Windows Found New Hardware Wizard appears, cancel it.

i wN

You are ready to install the print drivers. For details, see Installing the Software on page 40.

Connecting to a Telephone Line

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or driver type.
1. Ensure that the printer is turned off.

2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on
the back of the printer.

3. Connect the other end of the RJ11 cable to an operating telephone line.
4. Enable and configure the Fax functions.

For details, see the System Administrator Guide at www.xerox.com/office/WC3655docs.

Turning the Printer On and Off

This printer has both a power switch and a power button. The power switch on the side of the printer
controls the main power to the printer. The control panel power button controls power to the printer
electronic components. The preferred software-controlled printer shutdown method is to press the power
button.

To turn on the printer:
e  Turn on the power switch.

36 Xerox® WorkCentre® 3655 Multifunction Printer
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC3655&PgName=Man&Language=English

Installation and Setup

o If the power switch is on, but the printer is powered off, the printer was turned off using the power
button. To turn on the printer, on the control panel, press Power.

To turn off the printer:

A\ CAUTIONS:

e To prevent a printer malfunction or damage to the internal hard drive, perform the
power button shutdown first.

e Do not plug or unplug the power cord while the printer is powered on.

1. On the control panel, press Power.

s C— —)

2. Touch Power Down.

After 10 seconds, the touch screen goes dark and the Power Saver button flashes until the printer
has completed powering down.

Note: When all of the control panel lights are off, the printer power off sequence is complete.
Turning the power switch off is optional.
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Configuring Network Settings

This section includes:
®  ADOUL TCP/IP ANA IP AGQAIESSES....eeeeeeee et eeeeesseesasseessssesssssssssssassesasassassesasasessssesasasensasssnseesnsasens 38

About TCP/IP and IP Addresses

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network.
Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a
network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does
not require printers or computers to have IP addresses.

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and
cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server
automatically assigns an IP address to every computer and printer on the network that is configured to
use DHCP.

If you use a Cable or DSL router, see the documentation for your router for information on IP addressing.

38 Xerox® WorkCentre® 3655 Multifunction Printer
User Guide



Installation and Setup

Enabling the Printer for Scanning

If the printer is connected to a network, you can scan to an FTP address, an email address, or a shared
folder on your computer. First you must set up scanning in CentreWare Internet Services. For details, see
CentreWare Internet Services on page 27.

Note: If your printer is connected using the USB cable, you cannot scan to an email address or a
network location, such as a shared folder on your computer.

For details, see the System Administrator Guide at www.xerox.com/office/WC3655docs.
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Installing the Software

This section includes:

o Operating SyStemM REQUITEMENTS ... sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnns 40
e Installing the Print Drivers for a Windows NetWOork Printer ... creceeceessssesesnecsesssessssneens 40
e Installing the Print Drivers for @ Windows USB PriNter ... e eesseeessesessssesssssesnns 41
e Installing Print Drivers for Macintosh OS X Version 10.7 and LAter......eoneeonneesnreeseseessssessessenns 42
o Installing SCan Drivers fOr MACINTOSI ... ccreecriseceiieesesssessssseessssssessssssessssssssssssssssssssessssssesssssnesssssnees 43
e Installing Drivers and Utilities for UNIX aNd LiNUX ... eessesissseessseesssesesssesssssssasssssssesenns 43
® ORI DIIVETS .ottt tessse e ssase s e s s bbb bbb 44

Before you install driver software, verify that the printer is plugged in, turned on, connected correctly,
and has a valid IP address. If you cannot find the IP address, see Finding the IP Address of Your Printer
on page 28.

If the Software and Documentation disc is not available, download the latest drivers from
www.xerox.com/office/WC3655drivers.

Operating System Requirements

e  Windows Vista, Windows 7, Windows 8, Windows Server 2003, Windows Server 2008, Windows
Server 2008 R2, and Windows Server 2012.

e  Macintosh OS X version 10.7 and later.

UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface. For details, see www.xerox.com/office/WC3655drivers.

Installing the Print Drivers for a Windows Network Printer

1. Insert the Software and Documentation disc into the appropriate drive on your computer.

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe
installer file.

Click Network Installation.

At the bottom of the Driver Installation window, click Language.
Select your language, then click OK.

Click Next.

To accept the agreement, click I accept the terms, then click Next.

No v s WwWN

In the Discovered Printers list, select your printer, then click Next.

Note: When installing drivers for a network printer, if you do not see your printer in the list, click the
IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of your
printer, then click Search to locate your printer. If you do not know the IP address of the printer, see
Finding the IP Address of Your Printer.
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10.
11.

12.
13.
14,

Installation and Setup

To start the installation, click Next.

When the installation is complete, at the Enter Printer Settings screen, select the following as
needed:

—  Share this printer with other computers on the network
—  Set this printer as default for printing
Click Next.

In the Software and Documentation window, for any option you do not want to install, clear the
check box.

Click Install.
At the InstallShield Wizard, click Yes to restart your computer, then click Finish.

At the Product Registration screen, select your country from the list, then click Next. Complete the
registration form, then submit it.

Installing the Print Drivers for a Windows USB Printer

1.

No v WwWN

Insert the Software and Documentation disc into the appropriate drive on your computer.

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe
installer file.

At the bottom of the Driver Installation window, click Language.

Select your language, then click OK.

Select the printer model, then click Install Print and Scan Drivers.

To accept the agreement, click I Agree, then click Next.

At the Product Registration screen, from the list, select your country, then click Next.
Complete the registration form, then click Submit.

Note:The following applications are installed on your computer with the print driver:

e  Express Scan Manager
e  Address Book Editor

See also:

Online Support Assistant at: www.xerox.com/office/WC3655support
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Installing Print Drivers for Macintosh OS X Version 10.7 and Later

Install the Xerox print driver to access all features of your printer.

To install the print driver software:

No Uy .k WwWwN=

8.
0.
10.

Insert the Software and Documentation disc into the appropriate drive on your computer.

To view the .dmg file for your printer, double-click the disc icon on your desktop.

Open the .dmg file, then navigate to the appropriate installer file for your operating system.
Open the installer file.

To acknowledge the warning and introductory messages, click Continue. Click Continue again.
To accept the license agreement, click Continue, then click Agree.

To accept the current installation location, click Install, or select another location for the installation
files, then click Install.

Enter your password, then click OK.
Select your printer in the list of discovered printers, then click Continue.
If your printer does not appear in the list of discovered printers:

Click the Network Printer Icon.
Type the IP address of your printer, then click Continue.

Select your printer in the list of discovered printers, then click Continue.

11.
12.

To accept the print queue message, click OK.
To accept the installation success message, click Close.

Note: The printer is automatically added to the printer queue in Macintosh OS X version 10.4 and
later.

To verify that the print driver recognizes the installed options:

1.

s whN
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From the Apple menu, click System Preferences>Print and Scan.

Select the printer in the list, then click Options and Supplies.

Click Options.

Confirm that all of the options installed on the printer appear correct.

If you change settings, click OK, close the window, then exit System Preferences.
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Installing Scan Drivers for Macintosh

1. Insert the Software and Documentation disc into the appropriate drive on your computer.
2. Toview the .dmg file for your printer, double-click the disc icon on your desktop.

Open the Scan Installer.dmg file, then navigate to the appropriate installer file for your operating
system.

Open the Scan Installer package file.

To acknowledge the warning and introductory messages, click Continue.
To accept the license agreement, click Continue, then click Agree.

Click Continue again.

Enter your password, then click OK.

. If prompted to close other installations, click Continue Installing.

0. Torestart, click Log Out.

=0 ® NV

Installing Drivers and Utilities for UNIX and Linux

Xerox® Services for UNIX Systems is a two part installation process. It requires the installation of a
Xerox® Services for UNIX Systems code package and a printer support package. The Xerox® Services for
UNIX Systems code package must be installed before installing the printer support package.

Note: You must have root or superuser privileges to perform the UNIX print driver installation on
your computer.

1. Atthe printer, do the following:
e  Verify that both the TCP/IP protocol and the proper connector are enabled.
On the printer control panel, do one of the following for the IP address:
e Allow the printer to set up a DHCP address.
e  Enter the IP address manually.

Print the Configuration Report and keep it for reference. For details, see Configuration Report on page
26.

2. At your computer, do the following:
e  Go to www.xerox.com/office/WC3655driversand select your printer model.
From the Operating System menu, select UNIX, then click Go.

Select the Xerox® Services for UNIX Systems package for the correct operating system. This package is
the core package and must be installed before the printer support package.

To begin downloading, click the Start button.

Xerox® WorkCentre® 3655 Multifunction Printer 43
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC3655&PgName=driver&Language=English

Installation and Setup

Repeat steps a and b, then click the printer package for use with the Xerox® Services for UNIX Systems
package that you selected earlier. The second part of the driver package is ready for download.

To begin downloading, click the Start button.

In the notes below the driver package that you selected, click the link for the Installation Guide, then
follow the installation instructions.

Notes:

e Toload Linux print drivers, perform the preceding procedures but select Linux as the operating
system. Select Xerox® Services for Linux Systems driver or the Linux CUPS Printing Package. You
can also use the CUPS driver included in the Linux package.

e  Supported Linux drivers are available at www.xerox.com/office/WC3655drivers.

e  For details about UNIX and Linux drivers, see the System Administrator Guide at
www.xerox.com/office/WC3655docs.

Other Drivers

The following drivers are available for download at www.xerox.com/office/WC3655drivers.

e The Xerox® Global Print Driver works with any printer on your network, including those printers
made by other manufacturers. It configures itself for your individual printer upon installation.

e The Xerox® Mobile Express Driver works with any printer available to your computer that supports
standard PostScript. It configures itself for the printer you select every time you print. If you travel
frequently to the same sites, you can save your favorite printers in that location and the driver saves
your settings.
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Installing the Printer as a Web Service on
Devices

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated
services across a network. WSD supports device discovery, control, and use.

To install a WSD printer using the Add Device Wizard:

1.
2.
3.

4,

At your computer, click Start, then select Devices and Printers.
To launch the Add Device Wizard, click Add a Device.
In the list of available devices, select the one you want to use, then click Next.

Note: If the printer you want to use does not appear in the list, click the Cancel button. Add the
WSD printer manually using the Add Printer Wizard.

Click Close.

To install a WSD printer using the Add Printer Wizard:

0o NV s WN S

At your computer, click Start, then select Devices and Printers.

To launch the Add Printer Wizard, click Add a Printer.

Click Add a network, wireless, or Bluetooth printer.

In the list of available devices, select the one you want to use, then click Next.

If the printer you want to use does not appear in the list, click The printer that I want is not listed.
Select Add a printer using a TCP/IP address or hostname, then click Next.

From the Device type field, select Web Services Device.

Enter the printer IP address in the Hostname or IP address field, then click Next.

Click Close.
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Paper and Media

This chapter includes:

e  Supported Paper.......
e Loading Paper

e  Printing on Special Paper..........
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Supported Paper

This section includes:
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Your printer is designed to use various paper and other media types. To ensure the best print quality and
to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Recommended Media

A list of paper and media recommended for your printer is available at:
e www.xerox.com/paperRecommended Media List (United States)
e www.xerox.com/europaperRecommended Media List (Europe)

Ordering Paper

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC3655supplies.

General Paper Loading Guidelines

e Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
e Adjust the paper guides to fit the paper size.

e Fan paper before loading it in the paper tray.

e If excessive jams occur, use paper or other approved media from a new package.

e Do not print on label media once a label has been removed from a sheet.

e Use only paper envelopes. Print envelopes 1-sided only.
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Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage
your printer. Do not use the following:

e Rough or porous paper

e Inkjet paper

e Non-laser glossy or coated paper

e  Paper that has been photocopied

e  Paper that has been folded or wrinkled
e  Paper with cutouts or perforations

e Stapled paper

e Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes

e Plastic media

e Transparencies

i\.‘ CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction
Guarantee is available in the United States and Canada. Coverage could vary outside these areas.
Please contact your local representative for details.

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

e  Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly
damaging to paper.

e  Reduce the exposure of paper to strong lights for long periods of time.

e  Maintain constant temperatures and relative humidity.

e Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect
moisture.

e Store paper flat, either on pallets, cartons, shelves, or in cabinets.
e Avoid food or drinks in the area where paper is stored or handled.

e Do not open sealed packages of paper until you are ready to load them into the printer. Leave
stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or
gain.

e Some special media is packaged inside resealable plastic bags. Store the media inside the bag until
you are ready to use it. Keep unused media in the bag and reseal it for protection.
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Supported Paper Types and Weights

Trays Paper Types

All Trays Bond

Colored

Hole Punched
Plain
Pre-Printed
Recycled

Weights
(60-80 g/m?)

Bond
Colored

Hole Punched
Letterhead
Pre-Printed
Recycled

(81-105 g/m?)

Lightweight Cardstock

106-163 g/m?

Cardstock

(164-216 g/m?)

Labels

Bypass Tray only Envelope

Supported Standard Paper Sizes

European Standard Sizes North American Standard Sizes

All Trays A4 (210 x 297 mm, 8.3 x 11.7 in.)
B5(176 x 250 mm, 6.9 x 9.8 in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.)
JISB5(182 x 257 mm, 7.2 x 10.1 in.)
215x315mm, 85x12.4in.

Legal (216 x 356 mm, 8.5 x 14in.)

Folio (216 x 330 mm, 8.5x 13 in.)

Letter (216 x 279 mm,8.5 x 11in.)
Executive (184 x 267 mm, 7.25 x 10.5in.)
Statement (140 x 216 mm,5.5 x 8.5in.)
203 x 254 mm, 8 x 10 in.

Bypass Tray A6 (105 x 148 mm, 4.1 x 58 in.)
B6 (125 x 176 mm, 4.9 x 6.9 in.)

C5 envelope (162 x 229 mm,
6.4 x 9 in)

C6 envelope (114 x 162 mm,
45 x 6.38 in.)

DL envelope (110 x 220 mm,
433 x 866 in.)

JISB6(128 x 182mm, 5.0 x 7.2 in)
127 x178 mm, 5x 7 in.

Postcard (100 x 148 mm, 3.9 x 5.8 in.)
Postcard (148 x 200 mm, 5.8 x 7.9 in.)

Monarch envelope (98 x 190 mm,
39 x 7.5 in)

No. 9 envelope (99 x 226 mm,3.9 x 8.9 in)

No. 10 envelope (241 x 105 mm,
41 x 9.5 in)

Envelope 6 x 9 (152 x 228 mm,6x9 in.)
76 x127 mm, 3 x5in.

Postcard (89 x 140 mm, 3.5x 5.5 in.)
Postcard (102 x 152 mm, 4x 6 in.)
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Supported Paper Types and Weights for Automatic 2-Sided Printing

Paper Types

Bond
Colored

Hole Punched
Plain
Pre-Printed
Recycled

Weights
(60-80 g/m?)

Bond
Colored

Hole Punched
Letterhead
Pre-Printed
Recycled

(81-105 g/m?)

Lightweight Cardstock

106-163 g/m?

Supported Standard Paper Sizes for Automatic 2-Sided Printing

European Standard Sizes

North American Standard Sizes

A4 (210 x 297 mm, 8.3 x 11.7 in))
B5(176 x 250 mm,6.9 x 9.8 in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.)
JISB5(182 x 257 mm, 7.2 x 10.1 in.)
215x315mm, 85 x12.4in.

Legal (216 x 356 mm, 8.5 x 14in.)
203 x 254 mm, 8 x 10 in.

Folio (216 x 330 mm, 8.5x 13 in.)

Letter (216 x 279 mm, 85 x 11in.)
Executive (184 x 267 mm,7.25 x 10.5in.)
Statement (140 x 216 mm, 5.5 x 8.5in.)

Supported Custom Paper Sizes

Bypass Tray
e  Width: 76.2-215.9 mm (3-8.5in.)
e lLength: 127-355.6 mm (5-14in.)

Trays 1-4
e  Width: 139.7-215.9 mm (5.5-8.5in.)
e length: 210-355.6 mm (8.3-14in.)

Automatic 2-sided printing
e Width: 139.7-215.9 mm (5.5-8.5in.)
e length: 210-355.6 mm (8.3-14in.)
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Loading Paper

This section includes:

Loading PAper in the BYPASS TTAY .....ovvrrerrrinrieneenseinessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssenns 52
Loading Small Paper Sizes in the BYPASS TIAY ... urrerrienreeeneeesssesssssesssssssssesssssssssssssssssssssssssssssssssssssessssssees 54
Configuring Trays T—4 for the PAPEr LENGTN...... s sssssssinssssssssssesssssssssssssssssssssssssssssssssssssssssnes 57
LOAAING PAPET IN TIAYS T c..ooeeereerreeereeessessssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssessssssssssssssssssssssssns 58
CoNFIGUIING TIAY BENAVIOT oot ssssessssessasssssssessssssssssssssess s sssssss s ssssssasssssessssesssssesssns 60

Loading Paper in the Bypass Tray

1.
2.

52

Open the bypass tray.
If the bypass tray is loaded with paper already, remove any paper that is a different size or type.
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Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to
use it.

Load the paper in the tray.
Load hole punched paper with the holes to the right.

For 1-sided and 2-sided printing, to load letterhead or pre-printed paper, place letterhead face down

with the top edge going into the printer.
S

/

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to
jam.
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8. Adjust the width guides until they touch the edges of the paper.

—

\
\
9. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen.

Loading Small Paper Sizes in the Bypass Tray
1. Open the bypass tray.

Note: To simplify loading paper in the bypass tray, remove the tray from the printer.

2. Toremove the bypass tray from the printer, pull the tray straight out of the printer.
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3. If the bypass tray is loaded with paper already, remove any paper that is a different size or type.
4. Raise the paper stop.

f/

6. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to
use it.

7. Load the paper in the tray.

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to
jam.
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8. Adjust the width guides until they touch the edges of the paper.

9. Adjust the paper stop until it touches the edges of the paper.

11. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen.

For instructions on setting tray prompts, see Configuring Tray Behavior on page 60.
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Configuring Trays 1-4 for the Paper Length

You can adjust the lengths of trays 1-4 to accommodate A4/Letter and larger paper sizes. For the longer
length settings, the trays protrude from the front of the printer.

To change the 550-Sheet Feeders in trays 1-4 to match the paper length:
1. Remove all paper from the tray.

2. Toremove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly,
then pullit out.

3. To extend the tray, with one hand, hold the back of the tray. With the other hand, at the front of
the tray, press the release latch and pull the ends outward until they latch.

~

S\
NN

4. To protect the paper, place the paper cover over the extended section of the paper tray.
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5.  To compress the tray for shorter paper, with one hand, hold the back of the tray. With the other
hand, at the front of the tray, press the release latch, then push the ends inward until they latch.

6. Load paper into the tray, then insert it back into the printer. For details, see Loading Paper in Trays
1-4 on page 58.

Loading Paper in Trays 1-4

1. Toremove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly,
then pull it out.

2. Atthe back of the paper tray, press the paper lift tray down until it locks.
3. Adjust the paper length and width guides as illustrated.
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Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Load paper into the tray.

—  Load hole punched paper with the holes to the right.

— Load labels in the tray, face up.

—  For 1-sided and 2-sided printing, to load letterhead or pre-printed paper, place letterhead face
down with the top edge going into the printer.

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to

jam.
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7. Slide the tray back into the printer.

8. Push the tray in all the way.
Notes:
e If the tray does not go in all the way, ensure that the paper lift plate at the back of the tray is
locked down.

o If the tray is extended for legal size paper, the tray protrudes when it is inserted into the
printer.

e If the control panel prompts you, verify the paper size, type, and color in the Paper Settings
screen.

Configuring Tray Behavior

When an individual tray is set to Display Tray Prompt mode, the control panel prompts you to verify or
set the paper size and type.

The Tray Priority feature determines the order in which the printer selects the tray for a print job when
you have not specified one. Tray Priority also determines how the printer selects another tray when a
paper tray runs out in the middle of a job. Priority 1 indicates that the tray is set to the highest priority.

Tray Mode allows you to have the control panel or the print driver specify the bypass tray mode.

To set the Display Tray Prompt mode:

If needed, log in as administrator.

At the printer control panel, press the Machine Status button, then touch the Tools tab.
Touch Device Settings>Paper Management>Tray Settings.

Touch the desired tray.

Touch Change Settings.

For Tray Type, select an option.

o b wN~

— Dedicated: The paper loaded in the tray is the type specified under Paper Type and Color.
— Adjustable: The printer prompts you to confirm the type of paper loaded in the tray.
7. To have the print driver select the tray, enable Auto Selection for the source tray on the printer.
8. Change settings as needed, then touch Save.
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To set the priority for a tray:

If needed, log in as administrator.

At the printer control panel, press the Machine Status button, then touch the Tools tab.
Touch Device Settings>Paper Management>Tray Settings.

Touch the desired tray.

Touch Change Settings.

For Priority, touch the number, then, to enter a value, use the alphanumeric keypad.
Change settings as needed, then touch Save.

To establish priority for any remaining trays, repeat the steps.

NV W N =
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Printing on Special Paper

This section includes:
O ENVELOPES ..ottt RSt 62
° LODELIS ettt st s st st s st s st st s st s s s s st as b e e bt s s sasassasasssasssasaesasastasassasasassasastasas 65

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC3655supplies.

See also:
www.xerox.com/paperRecommended Media List (United States)
www.xerox.com/europaperRecommended Media List (Europe)

Envelopes

Print envelopes only from the Bypass Tray. For details, see Supported Standard Paper Sizes on page 50.

Guidelines for Printing Envelopes

e  Print quality depends on the quality and construction of the envelopes. Try another envelope brand
if you do not get desired results.

e  Maintain constant temperatures and relative humidity.

e  Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or
during printing.

e  Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book
on top of them.

e Inthe print driver software, select Envelope as the paper type.

e Do not use padded envelopes. Use envelopes that lie flat on a surface.

e Do not use envelopes with heat activated glue.

e Do not use envelopes with press and seal flaps.

e Use only paper envelopes.

e Do not use envelopes with windows or metal clasps.

62 Xerox® WorkCentre® 3655 Multifunction Printer
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC3655&PgName=order&Language=English
http://www.xerox.com/printer-supplies/recommended-paper/enus.html
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC3655&PgName=rmleu&Language=English

Paper and Media

Loading Envelopes in the Bypass Tray
1. Open the bypass tray.

~

Note: If you do not load envelopes in the bypass tray right after they have been removed from the
packaging, they can bulge. Flatten them to avoid jams.
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3. To load envelopes with long edge flaps, place the envelopes with the short edge going into the
printer, flaps down and to the left.

e
N

4. To load envelopes with non-adhesive short edge flaps, place print side up, flaps open and down,
with the bottom edge entering the printer.

L2
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5. For envelopes with adhesive short edge flaps, load the envelopes with the print side up, flaps closed
and down, and flaps going into the printer.
\%
Note: To have envelopes print correctly, when you load envelopes with the flaps open, in the print
driver, select Portrait,Landscape, or Rotated Landscape, as needed. To flip the image, in the print
driver, use Rotate Image 180 Degrees, as needed.
Labels

You can print labels from any tray.

Guidelines for Printing Labels

Use labels designed for laser printing.

Do not use vinyl labels.

Do not feed a sheet of labels through the printer more than once.

Do not use dry gum labels.

Print only on one side of the sheet of labels. Use full sheet labels only.

Store unused labels flat in their original packaging. Leave the sheets of labels inside the original
packaging until ready to use. Return any unused sheets of labels to the original packaging and
reseal it.

Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing
them in extreme conditions can cause print-quality problems or cause them to jam in the printer.

Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

In the print driver software, select Label as the paper type.
Before loading labels, remove all other paper from the tray.

/1 CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing

sheet. It could damage the printer.
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Loading Labels in the Tray

Remove all paper from the tray.

Load labels face up with the top edge toward the front of the tray.
Adjust the width guides until they touch the edges of the paper.
On the control panel, change the type to Label.

On the control panel, select the size.

Touch OK.

In the Printing Preferences of the print driver, on the Paper/Output tab, change the Paper Type
setting.

No vk WwWwN =
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This chapter includes:

68

Printing Overview

Selecting Printing Options....

Managing Jobs

69

73

Printing Features

76

Printing Special Job Types
Held Print Jobs

84

89

Print From

90
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Printing Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected to an
active network. Make sure that you have the correct print driver software installed on your computer. For
details, see Installing the Software on page 40.

1. Select the appropriate paper.

2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type.

3. Access the print settings in your software application. For most software applications, press CTRL+P
for Windows, or CMD+P for Macintosh.

4. Select your printer.

5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox®
Features for Macintosh. The title of the button can vary depending on your application.

6. Modify the print driver settings as necessary, then click OK.

7. Click Print to send the job to the printer.

See also:

Loading Paper on page 52

Selecting Printing Options on page 69

Printing on Both Sides of the Paper on page 76

Printing on Special Paper on page 62

68
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Selecting Printing Options

This section includes:

O PLINE DIIVEN HELP oottt ssss s s ssss s s s ssse s s s s s s ss s s s ssse s sssesssssssnsssns 69
®  WiINAOWS PriNtiNG OPLiONS ...t iieeeseciseesse e s e sssssssses s sss s ssssssssesssssssse s sssassasessssssasessssssssassnns 70
®  MACINtOSH PriNtiNG OPLIONS .....vververreesirreisssissssssstsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssssssssssns 71
®  LiNUX PriNtiNG OPLIONS ... e sisssssssssssssssssssssssssssssssssssssessssssssssssssssssssssessssssssessssssssessssesssssssssssssssssssnns 72

Printing options, also called print driver software options, are specified as Printing Preferences in
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page
layout, and print quality. Printing options that are set from Printers and Faxes Printing Preferences
become the default setting. Printing options that are set from within the software application are
temporary. The application and the computer do not save the settings after the application is closed.

Print Driver Help

Xerox® print driver software Help information is available from the Printing Preferences window. Click the
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help.

> =
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Information about Printing Preferences appears in the Help window on two tabs:

e Contents provides a list of the tabs at the top and the areas at the bottom of the Printing
Preferences window. Use the Contents tab to find explanations for each of the fields and areas in
Printing Preferences.

e Search provides a field where you can enter the topic or function for which you need information.

Xerox® WorkCentre® 3655 Multifunction Printer 69
User Guide



Printing

Windows Printing Options

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the
Printing Preferences window. You can specify your most common printing options and save them so that
you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in
Printing Preferences.

To select default printing options:
1. Navigate to the list of printers on your computer:
—  For Windows Vista, click Start>Control Panel>Hardware and Sound>Printers.
—  For Windows Server 2003 and later, click Start>Settings>Printers.
—  For Windows 7, click Start>Devices and Printers.
—  For Windows 8, click Control Panel>Devices and Printers.
Note: If the Control Panel icon does not appear on the desktop, right-click on the desktop, then
select Personalize>Control Panel Home>Devices and Printers.
2. Inthe list, right-click the icon for your printer and click Printing Preferences.
3. Inthe Printing Preferences window, click a tab, select the options, then click OK to save.

Note: For more information about Windows print driver options, click the Help button (?) in the
Printing Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before
sending the job to the printer. For example, if you want the highest print quality when you print a
document, in Printing Preferences, select High Resolution, then submit the print job.

1. With the document open in your software application, access the print settings. For most software
applications, click File>Print or press CTRL+P.

2. To open the Properties window, select your printer, then click the Properties or Preferences button.
The title of the button varies depending on your application.

3. Click atab in the Properties window, then make selections.
4. To save your selections and close the Properties window, click OK.
5. Tosend the job to the printer, click OK.
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Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1.
2.

With the document open in your application, click File>Print.

Select the printer, then click Properties. Click the tabs in the Properties window, then select the
desired settings.

To save the settings, click the arrow to the right of the Saved Settings field at the bottom of the
window, then click Save As.

Type a name for the set of printing options, then to save the set of options in the Saved Settings list,
click OK.

To print using these options, select the name from the list.

Macintosh Printing Options

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.

1.

v W

With the document open in your application, click File>Print.
Select your printer.

Select Xerox® Features from the Copies & Pages menu.
Select the desired printing options from the drop-down lists.
Click Print to send the job to the printer.

Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

o wNe=

With the document open in your application, click File>Print.

Select your printer from the Printers list.

Select the desired printing options from the drop-down lists in the Print dialog box.

Click Presets>Save As.

Type a name for the printing options, then click OK to save the set of options in the Presets list.
To print using these options, select the name from the Presets list.
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Linux Printing Options

Launching Xerox® Printer Manager

To launch Xerox® Printer Manager from a terminal window prompt as root, type xeroxprtmgr, then press
Enter or Return.

Printing from a Linux Workstation

The Xerox® print driver accepts a job ticket setting file that contains preset printing features. You can
also submit print requests through the command line using Ip/lpr. For more information about Linux
printing, click the Help (?) button in the Xerox® GUI print driver.

To print from a Linux workstation:
1. Create a print queue.

2. With the desired document or graphic open in your application, open the Print dialog box. For most
software applications, click File>Print or press CTRL+P.

Select the target print queue.

Close the Print dialog box

In the Xerox® GUI print driver, select the available printer features.
Click Print.

o v W

To create a job ticket using the Xerox® GUI print driver:

1. Open the Xerox® GUI print driver.

Note: To open the Xerox® GUI print driver, as root, type xeroxprtmagr.
2. Onthe My Printers screen, select the printer.
3. Inthe top corner, click Edit Printer, then select options for the print job.
4. Click Save As, then store the job ticket in your home directory.

Note: Personally identifiable information, such as a Secure Print passcode, is not saved in the job

ticket. You can specify the information on the command line.

To print using the job ticket, type the command lp -d{Target_Queue} -

oJT=<path_to_ticket><file_name>.

The following commands are examples of how to print using a job ticket:
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lp -d{Target_Queue} -0JT={Absolute_Path_To_Job_Ticket} {Path_To_Print_File}
[p -dMyQueue -0JT=/tmp/DuplexedLetterhead /home/user/PrintReadyFile
lp -dMyQueue -0JT=/tmp/Secure -oSecurePasscode=1234 /home/user/PrintReadyFile
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Managing Jobs

This section includes:

o Managing JObs at the CONTIOL PANEL.........eerneisreseisssissessssessssssssssssssssssssssssssssssssssssssssssssssssssssssssenns 73
e  Managing Secure and Held PriNT JODS ...ttt sass s ssse s sanes 74
e Managing Jobs in CentreWare INTErNet SEIVICES ...t ssssssssssssssssssssssssssssssssssssssssssssenns 75

Managing Jobs at the Control Panel

From the control panel Job Status, you can view lists of active jobs, secure jobs, or completed jobs. You
can pause, delete, print, or view job progress or job details for a selected job. For details, see Printing
Special Job Types on page 84.

To pause printing:
1. At the control panel, press the Interrupt button. The printer continues to print while it determines
the best place to pause the spooled print job.

2. Toresume printing, press the Interrupt button again.

To pause the print job with the option to delete it:
1. At the control panel, press the Stop button.
2. Do one of the following:
— To delete the print job, touch Cancel Printing.
—  Toresume the print job, touch Resume Printing.

Note: If you do not make a selection within 60 seconds, the job automatically resumes.

To view active, secure, or completed jobs:
1. Atthe control panel, press the Job Status button.
2. Tosee a list of specific job types, touch a tab.
— Toview jobs that are processing or waiting to process, touch the Active Jobs tab.

—  To view Secure Print jobs, touch the Secure Print Jobs, or My Secure Jobs tab. Touch the
folder, enter the passcode number using the keypad, then touch OK.

—  To view completed jobs, touch the Completed Jobs tab.
3. Torefine the list, touch the Down arrow.
4, To see details about a job, touch the job.
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To delete a job:
1. At the control panel, press the Job Status button.
2. From any of the job type tabs, touch the job.
3. Touch Delete.
Notes:
e The system administrator can restrict users from deleting jobs. If a system administrator has
restricted job deletion, you can view the jobs, but not delete them.
e  Only the user that sent the job or the system administrator can delete a secure print job.

From the Print From menu, you can view lists of saved jobs, jobs stored on a USB Flash drive, or jobs
stored in printer folders. You can select and print jobs from any of the lists. To print the job, see Printing
Special Job Types on page 84.

To view saved jobs:

1. At the printer control panel, press the Services button.
2. Touch Print From, then touch Saved Jobs.

3. Toview the saved jobs, touch a folder.

4. To see details about a job, touch the job.

Managing Secure and Held Print Jobs

When you send a secure print job, the job is held until you release it by typing a passcode at the control
panel.

To view a list of secure print jobs:

1. At the printer control panel, press the Job Status button.

2. Touch Secure Print Jobs or My Secure Jobs. For details, see Secure Print on page 84.

3. Note: Only the user that sent the job or the system administrator can delete a secure print job.

If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is held
until you release it. For details, see Releasing Held Print Jobs on page 89.

Unidentified jobs are jobs that are not associated with a user name. Unidentified jobs originate from a
computer that does not require a user to log in. Examples are a job sent from a DOS or UNIX window
using LPR, Port 9100, or from the Jobs tab in CentreWare Internet Services.

To view a list of the unidentified jobs and release them:

1. Touch the Unidentified Print Jobs tab.

2. Do one of the following:
— Torelease a held job, touch the job, then touch Release.
— Torelease all held jobs, touch Release All Jobs.

A print job can be held by the printer when it is unable to complete a print job. For example, it needs
attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing.

74 Xerox® WorkCentre® 3655 Multifunction Printer
User Guide



Printing

Managing Jobs in CentreWare Internet Services

You can view a list of active jobs and delete print jobs from the Active Jobs list in CentreWare Internet
Services. You can also print, copy, move, or delete saved jobs. For details, see the Help in CentreWare

Internet Services.
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Printing Features

This section includes:
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Printing on Both Sides of the Paper

Paper Types for Automatic 2-Sided Printing

The printer can print a 2-sided document automatically on supported paper. Before printing a 2-sided
document, verify that the paper type and weight are supported. For details, see Supported Paper Types
and Weights for Automatic 2-Sided Printing on page 51.

Printing a 2-Sided Document

Options for Automatic 2-Sided Printing are specified in the print driver. The print driver uses the settings
for portrait or landscape orientation from the application for printing the document.
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2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn.
These settings override the application page orientation settings.

Portrait Landscape
BB o
» L

Portrait Portrait Landscape Landscape
2-Sided Print 2-Sided Print, Flip on Short | 2-Sided Print 2-Sided Print, Flip on Short
Edge Edge

Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to
use based on the document size, paper type, and paper color you specify. You can also select a specific
tray loaded with the desired paper.

Printing Multiple Pages to a Single Sheet
When printing a multiple-page document, you can print more than one page on a single sheet of paper.

Print 1, 2, 4, 6,9, or 16 pages per side by selecting Pages Per Sheet on the Page Layout tab. Page Layout
is on the Document Options tab.
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Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any
paper size that is supported for 2-sided printing. The driver automatically reduces each page image and
prints four page images per sheet of paper, two page images on each side. The pages are printed in the
correct order so that you can fold and staple the pages to create the booklet.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter

and creep.

e  Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm
(1/72in.).

e  Creep: Specifies how much the page images shift outward in tenths of a point. Shifting
compensates for the thickness of the folded paper, which can cause the page images to shift
outward slightly when folded. You can select a value from zero to 1 point.

Gutter Creep

|
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|

|

|

|

-

|
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Print Quality

Print-quality modes:

e Standard print-quality mode: 600 x 600 dpi

e High Resolution print-quality mode: 1200 x 1200 dpi

e Toner Saver print-quality mode
—  This mode reduces the amount of toner used for print jobs.
—  You can use this feature for draft quality output.

Lightness

Lightness allows you to adjust the overall lightness or darkness of the text and images in your printed

job.

1. To adjust the lightness, on the Image Options tab, move the slider to the right to lighten or to the
left to darken your print job.

2. Click OK or Apply.
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Contrast

Contrast allows you to adjust the variation between light and dark areas of the print job.

1. To adjust the contrast, move the slider to the right to reduce the contrast or to the left to increase
the contrast.

2. Click OK or Apply.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages
that are different from the source used for the body of a document. For example, you can use your
company letterhead for the first page of a document. You can also use heavyweight paper for the first
and last pages of a report. You can use any applicable paper tray as the source for printing cover pages.

Select one of these options for printing cover pages:

e No Covers does not print cover pages. No cover pages are added to the document.

e  Front Only prints the first page on paper from the specified tray.

e  Back Only prints the back page on paper from the specified tray.

e Front and Back: Same prints the front and back cover pages from the same tray.

e Front and Back: Different prints the front and back cover pages from different trays.

After making a selection for printing the cover pages, you can select the paper for the front and back
covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one, side
two, or both sides of the cover pages.

Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated

pages within a document. Adding an insert after designated pages within a document separates

sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages.

e Insert Options provides the options to place an insert After Page X, where X is the specified page, or
Before Page 1.

e Insert Quantity specifies the number of pages to insert at each location.

e Pages specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6,9, 10, and 11, type 1,6,9-11.

e Paper displays the default size, color, and type of paper selected in Use Job Settings. Click the Down
arrow to the right of the Paper field to select a different paper size, color, or type.

e Job Setting displays the attributes of the paper for the remainder of the job.
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Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences
such as page size, page type, and page color. You can also change the side of the paper on which to print
as your job requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to
print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the
alternate paper source:

e Pages specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6,9, 10, and 11, type 1,6,9-11.

e  Paper displays the default size, color, and type of paper selected in Use Job Settings. Click the Down
arrow to the right of the Paper field to select a different paper size, color, or type.

e 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an
option:
— 1-Sided Print prints the exception pages on one side only.

—  2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the
long edge. The job then can be bound on the long edge of the pages.

—  2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and
flips the pages on the short edge. The job then can be bound on the short edge of the pages.

— Use Job Setting prints the job using the attributes shown in the Job Settings box.
e Job Setting displays the attributes of the paper for the remainder of the job.

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce
unexpected results.

Scaling

You can reduce the image to as little as 25 % of its original size or enlarge it as much as 400 % . In
Windows, you can find the Scale Options in the print driver on the Printing Options tab.qaaaq
200%

50% 100%

XEROX

XEROX
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1. To access Scaling Options, to the right of the Paper field, click the arrow, then select Other
Size>Advanced Paper Size.

2. Select an option.

No Scaling: You can use this option to retain the original image size.

Automatically Scale: You can use this option to change the print from one standard paper size
to another. The Original Document Size is scaled to fit on the selected output paper size shown
in the Output Paper Size field.

Manually Scale: You can use this option to change the output print size by a specified
percentage.

Printing Watermarks

A watermark is special purpose text that can be printed across one or more pages. For example, you can
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before
distribution.

Notes:

Not all options listed are supported on all printers. Some options apply only to a specific printer
model, configuration, operating system, or driver type.

Watermarks are not supported for some print drivers when booklet is selected or when more
than one page is printed on a sheet of paper.

Using the watermark options, you can do the following:

e  Create a watermark or edit an existing watermark using the Watermark Editor:

A Text Watermark uses the characters typed in the Text field as the watermark. You can create
a text watermark to print on a document. Select options such as font size, font type, font color,
and angle.

A Picture Watermark uses an image as the watermark. The picture file can be in .bmp, .gif, or
Jjpg format. You can create a picture watermark to print on a document, and select options
including size and position on the page.

A Time Stamp Watermark uses a time stamp as the watermark. You can create a time stamp
watermark to print on a document. Time stamp elements include the day, date, time, and time
zone.

e  Place a watermark on the first page or on every page in a document.

e  Print a watermark in the foreground or background or blend it with the print job.
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To print a Watermark:

1.
2.
3.

Click Document Options>Watermark.

From the Watermark menu, select the watermark.

Click Layering, then select how to print the watermark:

—  Print in Background prints the watermark behind the text and graphics in the document.

—  Blend combines the watermark with the text and graphics in the document. A blended
watermark is translucent, so you can see both the watermark and the document content.

—  Print in Foreground prints the watermark over the text and graphics in the document.
Click Pages, then select the pages on which to print the watermark:

—  Print on All Pages prints the watermark on all pages of your document.

—  Print on Page 1 Only prints the watermark only on the first page of the document.
Click OK.

Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right
when printed.

Creating and Saving Custom Sizes

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print
driver and are available for you to select in all your applications. For paper sizes that are supported for
each tray, see Supported Custom Paper Sizes on page 48.

To create and save custom sizes for Windows:

1.
2.
3.
4

5.

In the print driver, click the Printing Options tab.
For Paper, click the arrow, then select Other Size>Advanced Paper Size>Output Paper Size>New.
In the New Custom Paper Size window, enter the height and width of the new size.

To specify the units of measurement, at the bottom of the window, click the Measurements button,
then select Inches or Millimeters.

To save, in the Name field, type a title for the new size, then click OK.

To create and save custom sizes for Macintosh:

o~ wN=
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In the application, click File>Page Setup.

Click Paper Sizes, then select Manage Custom Sizes.

To add a new size, in the Manage Paper Sizes window, click the plus sign (+).

At the top of the window, double-click My Custom Size, then type a name for the new custom size.
Enter the height and width of the new custom size.

Click Print Margins, then select the printer from the list. Or set the top, bottom, right, and left
margins.

To save the settings, click OK.

Xerox® WorkCentre® 3655 Multifunction Printer
User Guide



Printing

Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer
screen with the name of the job and the name of the printer where it was printed.

Note: This feature is available on a computer printing to a network printer.

To be notified when your print job completes:

1. Inthe print driver, click the Printing Options tab.

2. Click Notification>Notify for Completed Jobs>Enabled.
3. Click OK.
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Printing Special Job Types

This section includes:
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Special job types allow you to send a print job from your computer, then print it from the printer control
panel.

Select special job types in the print driver from the Printing Options tab.

Secure Print

Secure print allows you to associate a 4—10 digit passcode with a print job when sending it to the printer.
The job is held at the printer until you enter the passcode at the control panel.

When printing a series of secure print jobs, you can assign a default passcode in the Printing Preferences
of the print driver. Then you can use the default passcode for all print jobs sent from that computer. If
you must use a different passcode, you can override it in the application print driver.

Sending a Secure Print Job

1.
2.
3.
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On the Printing Options tab, from the Job Type list, select Secure Print.
Type a 4-10 digit passcode for the Secure Print job.
In the Confirm Passcode field, type the passcode again.

Notes:

e If you do not supply a passcode, the printer assigns a passcode and displays it in the Passcode
Required window. You can use the passcode supplied by the printer, or you can type your own
passcode to use in the Secure Print window.

e The passcode is associated with your user name. After you set a passcode, it becomes the
default passcode for any print job that requires a passcode on all Xerox® printers. You can reset
the passcode at any time from any window that contains the passcode.

Click OK.

Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
Select an option for 2-sided printing.

Select a print-quality mode.

Select another tab or click OK.

To send the job to the printer, in the Print window, select the number of copies to print, then click
OK or Print.
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Releasing a Secure Print

1.

v whN

At the control panel, press the Job Status button.

Touch the Secure Print Jobs or My Secure Jobs tab.

Touch the folder that holds the print job.

Using the keypad, enter the passcode that you assigned to the print job, then touch OK.
Touch the corresponding print job in the list, then touch Release.

Deleting a Secure Print

1. Atthe control panel, press the Job Status button.

2. Touch the Secure Print Jobs or My Secure Jobs tab.

3. Touch the folder that holds the print job.

4. Enter the passcode number that you assigned to the print job using the keypad.
5. Touch the corresponding print job in the list, then touch Delete.

Sample Set

The Sample Set job type allows you to print a sample copy of a multiple-copy job and hold the
remaining copies at the printer. After you review the sample copy, you can select the job name from the
printer control panel to print the additional copies.

Sending a Sample Set Print Job

ot wN-=

On the Printing Options tab, from the Job Type list, select Sample Set.

Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
Select an option for 2-sided printing.

Select a print-quality mode.

Select another tab or click OK.

To send the job to the printer, in the Print window, select the number of copies to print, then click
OK or Print.

A sample copy prints immediately. The sample copy is not counted as part of the print job.
After reviewing the copy, use the printer control panel to print or delete the remaining copies.

Note: You can use Sample Set as a part of the Earth Smart settings. In Earth Smart settings, set
Sample Set as your default Job Type.

To print the job, select it from the job list on the printer control panel.
Press OK.
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Releasing the Remaining Prints After Printing a Sample Set

1. At the control panel, touch Job Status.
2. Touch the corresponding print job in the list.
Note: The control panel displays Held: Sample Set next to the job name.
3. Touch Release.
The remainder of the job prints, and the job is deleted from the printer hard drive.
Delay Print

You can delay a print job for up to 24 hours from the original job submission time. Enter the time at
which you would like the job to print. If the time you enter is earlier than the time that you submit the
print job, it prints on the following day. The Delayed Print default time is midnight.

Sending a Delay Print Job

1.
2.

On the Printing Options tab, from the Job Type list, select Delay Print.

In the Delay Print window, select the Tab key to move from the hour section to the minutes section.
To select the time to send the print job, click the arrow buttons.

—  For a12-hour time format, type the hour (1-12), minutes (00-59), then select A.M. or P.M. To
toggle between A.M. and P.M,, click A.M. or P.M., then use the Up arrow or Down arrow
buttons.

—  For a 24-hour time format, type the hour (1-23) and the minutes (00-59).
Note: The regional settings on your computer determine the time format.

Click OK.
Select other desired printing options and click OK.
Click OK or Print.

Note: To print the job after you send it but before the scheduled time, release the job at the printer
control panel.

Saved Job

Saved Job or Store File in Folder stores a public or private job in the printer and prints the job as
requested at the printer control panel. This option is useful for documents that you print frequently. You
can assign a passcode to a private job to prevent unauthorized printing.

To print saved jobs, see Printing from Saved Jobs.
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Sending a Public Saved Job

1.
2.
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12.
13.

On the Printing Options tab, from the Job Type list, select Saved Job.

In the Saved Job window, for Job Name, do one of the following:

—  Type a name for the job.

—  Click the arrow to the right of the field and select a name from the list.

—  Click the arrow to the right of the field and select Use Document Name to use the name of the
document.

Note: The print driver retains 10 names. When adding an 11th name, the name used least is deleted
automatically from the list. To remove names from the list other than the selected name, select
Clear List.

In Save To or Folder Number, specify where you want the file saved on the printer. Do one of the
following:

—  Type the name of the destination folder.

—  Click the arrow to the right of the field, then select a folder name from the list.

—  Click the arrow to the right of the field, then select Default Public Folder.

To print the job now and also save the job, select the Print and Save check box.

Select Public.

Click OK.

Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
Select an option for 2-sided printing.

Select a print-quality mode.

Select another tab or click OK.

To send the job to the printer, in the Print window, select the number of copies to print, then click
OK or Print.

A sample copy prints immediately. The sample copy is not counted as part of the print job.
To print the job, select it from the job list on the printer control panel.

Press OK.

After the job is saved, you can print it as needed. For details, see Printing from Saved Jobs.
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Sending a Private Saved Job

1. On the Printing Options tab, from the Job Type list, select Saved Job.
2. Inthe Saved Job window, for Job Name, do one of the following:
—  Type a name for the job.
—  Click the arrow to the right of the field and select a name from the list.
—  Click the arrow to the right of the field and select Use Document Name to use the name of the
document.

Note: The print driver retains 10 names. When adding an 11th name, the name used least is deleted
automatically from the list. To remove names from the list other than the selected name, select
Clear List.

3. InSave To or Folder Number, specify where you want the file saved on the printer. Do one of the
following:
—  Type the name of the destination folder.
—  Click the arrow to the right of the field, then select a folder name from the list.
—  Click the arrow to the right of the field, then select Default Public Folder.
4, To print the job now and also save the job, select the Print and Save check box.
5. Tostore your job at the printer, select Private.

6. Inthe Passcode field, type a passcode. The passcode is associated with your user name. After you
set a passcode, it becomes the default passcode for any print job that requires a passcode on all
Xerox® printers. You can reset the passcode at any time from any window that contains the
passcode.

7. Inthe Confirm Passcode field, type the passcode again.
8. Click OK.
9. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
10. Select an option for 2-sided printing.
11. Select a print-quality mode.
12. Select another tab or click OK.
13. To print the job, select it from the job list on the printer control panel.
14. Press OK.
After the job is saved, you can print it as needed. For details, see Printing from Saved Jobs.
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Held Print Jobs

Jobs can be held or paused for various reasons. For example, if the printer is out of paper, the job holds.
If you send a sample job, the first copy of the job prints and the rest of the copies hold until you release
them. If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is
held until you release it.

Releasing Held Print Jobs

At the control panel, press the Job Status button.

Touch Active Jobs.

To determine why a job was held, touch the job, then touch Details.
Do one of the following:

Ewhh=

— Torelease a held job, touch the job, then touch Release.
— Torelease all held jobs, touch Release All Jobs.
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Print From

Print From allows printing of documents stored on the printer, on a computer on a network, or on a USB
Flash drive.

Printing from a USB Flash Drive

You can print .pdf, .ps, .pcl, .prn, .tiff, and .xps files directly from a USB Flash drive.
Notes:
e If USB ports are disabled, you cannot use a USB card reader for authentication, update the
software, or print from a USB Flash drive.

e  The system administrator must set up this feature before you can use it. For details, see the
System Administrator Guide at www.xerox.com/office/WC3655docs.

To print from a USB Flash drive:

1. Insert your USB Flash drive in a USB port on the printer. The Print from USB window appears.

The list at the bottom of the window displays the folders and printable files on the USB Flash drive.
To scroll through the list and locate the printable file, next to the list, use the arrows.

If the print file is in a folder, to open the folder, touch the name.

Touch the name of the printable file.

i &~ wN

Select the number of copies, paper size, paper color, paper type, 2-sided printing, and finishing
options.

Press the green Start button.

N o

To go back to the last screen, touch Back.
8. Tolook for other folders and printable files, touch Browse.

Printing from Saved Jobs

1. Atthe control panel, press the Services button, then touch Print From.

2. Select Saved Jobs, then touch the name of the folder containing the saved job.

3. Touch the name of the saved job that you want to print.
Note: To print a private saved job, touch the name of the job, then enter the passcode.

4. Select the number of copies, paper size, paper color, paper type, 2-sided printing, and finishing
options.

5. Press the green Start button.

6. After the job prints, to return to the list of saved jobs, touch Browse.

7. Toreturn to the list of folders, touch Back.
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Printing from a Mailbox

Print from mailbox allows you to print a file that is stored in a folder on the printer hard drive.

To print from a mailbox:

1.
2.

At the control panel, press the Services button, then touch Print From.

Select Mailbox, then touch the name of the folder containing the document.

Note: If Mailbox is not displayed, use CentreWare Internet Services to enable the Scan to Mailbox
and Print From Mailbox features. Then create a scan to mailbox folder. For details, see the System
Administrator Guide at www.xerox.com/office/WC3655docs.

Touch the name of the document that you want to print.

Select the number of copies, paper size, paper color, paper type, 2-sided printing, and finishing
options.

Press the green Start button.
After the job prints, to return to the list of documents in the mailbox, touch Browse.
To return to the list of folders, touch Back.
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Printing from CentreWare Internet Services

You can print .pdf, .ps, .pcl, .prn, and .xps files directly from CentreWare Internet Services without having
to open another application or the print driver. You can store the files on a local computer hard drive,
mass storage device, or network drive.

To print from CentreWare Internet Services:

1.

92

At your computer, open a Web browser, in the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer
on page 28.
In CentreWare Internet Services, click the Print tab.

To select the file from a local network or remote location, click Browse, select the file, then click
Open.

For Printing, select the desired options for the job.
— Normal Print prints a job immediately.
—  Secure Print prints a job after you enter your passcode at the printer control panel.

—  Sample Set, or Proof Print, prints one copy of a multiple-copy print job and holds the remaining
copies at the printer.

— Save Job for Reprint saves a print job in a folder on the print server for future printing. You can
specify a job name and folder.

—  Delay Print prints a job at a specified time up to 24 hours from the original job submission.
If Accounting is enabled, enter your User ID and account information.
Click Submit Job.

Note: To ensure that the job was sent to the queue, wait for the job submission confirmation
message to appear before you close this page.
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This chapter includes:
94

e Basic Copying........
o Adjusting COPYING OPLIONS .....verrrerrrrnrrirnsssneenssessssssssssssssssssssssssssssssssssssssssssssssssssenns 97
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Basic Copying

1. To clear previous settings, press the yellow Clear All button on the control panel.
2. Load your original documents:

—  Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the document
glass.

—  Use the document feeder for multiple or single pages. Remove any staples and paper clips from
the pages and place them face up in the document feeder.

3. Press the Services Home button, then touch Copy.
4.  Use the alphanumeric keypad on the control panel to enter the number of copies. The number of
copies appears in the upper right corner of the touch screen.

Note: To correct the number of copies entered using the alphanumeric keypad, press the C button,
then re-enter the number.

5. Change the copy settings as needed. For details, see Selecting Copy Settings.
6. Pressthe green Start button.

Notes:

e To pause or cancel a copy job, press the red Stop button on the control panel.
e Tointerrupt a copy job, press the Interrupt button on the control panel.

e  On the touch screen, touch Resume Scanning to continue the job, or Cancel Scanning to cancel
the job completely.

Document Glass

e Lift the document feeder cover and place the
first page face down in the upper left corner of
the document glass.

o Align the originals to the matching paper size
printed on the edge of the glass.

e The document glass accommodates original
sizes up to 216 x 356 mm (8.5 x 14in.).
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Document Glass Guidelines
The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.).

To copy or scan the following types of originals, use the document glass rather than the duplex
automatic document feeder.

e  Paper with paper clips or staples attached

e  Paper with wrinkles, curls, folds, tears, or notches

e  Coated or carbonless paper or items other than paper such as cloth or metal
e Envelopes

e Books

Document Feeder

e Insert originals face up, with page one on top.

e The confirmation indicator illuminates when
you load the originals correctly.

e Adjust the paper guides so they fit against the
originals.

e The document feeder supports paper weights
of 50-125 g/m? for 1-sided pages, and
60-125 g/m?for 2-sided pages.

e The document feeder supports paper sizes
from 139.7 x139.7 mm (5.5x 5.5 in.)
through 215.9 x 355.6 mm (8.5x 14 in.).

e The maximum document feeder capacity is
approximately 60 sheets of 80 g/m? paper.

Duplex Automatic Document Feeder Guidelines

When loading originals into the duplex automatic document feeder, follow these guidelines:

e Insert originals face up with the top of the page entering the feeder first.

e  Only place loose sheets of paper in the duplex automatic document feeder.

e Adjust the paper guides so that they fit against the originals.

e  Only Insert paper in the duplex automatic document feeder when ink on the paper is dry.
e Do not load originals above the MAX fill line.
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Copying an ID Card

You can copy both sides of an ID card or small document onto one side of paper. Each side is copied
using the same location on the document glass. The printer stores both sides and prints them side by
side on the paper.

To copy an ID card:

1.
2.
3.

10.
11.

96

At the printer control panel, press the Services Home button.
Touch ID Card Copy.

For side 1, under the ID Card Copy tab, verify the paper supply, lightness/darkness, sharpness, and
auto suppression background settings. Change the settings as needed.

Lift the document cover.

Place the ID card, or a document smaller than half the selected paper supply size, about 6 mm (.25
in.) from the upper left corner of the document glass.

Press the green Start button.
Lift the document cover.

For side 2, turn the document over and position it about 6 mm (.25 in.) from the upper left corner of
the document glass.

Touch Scan Side 2.
To exit, press the Services Home button.
Remove the ID card from the scanner.
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Adjusting Copying Options

This section includes:

O BlOSIC SOULINGS ettt sttt s s s s R st 98
®  IMAGE-QUALLY SELLINGS c.oovreeerreeeeeeeceseseese e ssassesssessssse s ssssesssssesssssessssesssssesssssess s s sssesssasess s ssssassasessssesssns 99
O OULPUL AQJUSTIMENTS ..oooveeerreesceesiessstssssssssssssesssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssssssssasssssssssssssssnsssssssnnees 100

You can adjust numerous options for your copy jobs, specify characteristics of the original documents,
and customize the output. For details, see Basic Copying on page 98.

You can also modify the default settings for many options. For details, see Selecting Default Copy
Settings.
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Basic Settings

This section includes:

®  SElECHING U PAPET TIAY coorverrterreeeriessesssiessessissssassssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssnsssnssssns
o Making the IMAge LIGter OF DAIKET ... ssssssssissssssssssssssssssssssssssssssssssssssssssssssssssssssnssssssnns
0 Setting 2-Sided COPYING .t eese i e eese s easse s sssses s essesb s sssssb st s s e bbb sssssasessnas

Selecting a Paper Tray

1. At the printer control panel, press the Services Home button.
2. Touch Copy.

3. Touch the Copy tab.

4.  For Paper Supply, touch the desired tray.

Making the Image Lighter or Darker

At the printer control panel, press the Services Home button.

Touch Copy.

Touch the Image Quality tab.

Touch Image Options.

To lighten or darken the image, for Lighten/Darken, move the slider up or down.
Touch OK.

o b whNe~

Setting 2-Sided Copying

1. At the printer control panel, press the Services Home button.
2. Touch Copy.

3. Touch the Copy tab.

4.  For 2-Sided Copying, select an option.
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Image-Quality Settings

This section includes:

o  Specifying the Original DOCUMENT TYPE ... ssssisssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssenns 99
®  AdJUSEING The SNAMPNESS ...ttt ssss s ss s ssssssssss s s s s s s s s sssnsss s s s sssasssssssss s sssnssens 99
®  AULO BACKGIOUNT SUPPIESSION......ou ettt stessessssssssss s ssesssassssssssssssssssssassssssssssssssssssasssassssssssnssnssasssanes 99

Specifying the Original Document Type

To specify the type of the original document:

At the printer control panel, press the Services Home button.
Touch Copy.

Touch the Image Quality tab.

Touch Original Type.

Touch an option.

Touch OK.

o kswN-~

Adjusting the Sharpness

At the printer control panel, press the Services Home button.
Touch Copy.

Touch the Image Quality tab.

Touch Image Options.

For Sharpness, move the slider up or down.

Touch OK.

o bhwN-~

Auto Background Suppression

When copying originals printed on thin paper, text or images printed on one side of the paper can be
seen on the other side. Use the Auto Background Suppression setting to reduce the sensitivity of the
printer to variations in light background colors.

To turn on Auto Background Suppression:

At the printer control panel, press the Services Home button.
Touch Copy.

Touch the Image Quality tab.

Touch Image Enhancement.

Under Background Suppression, touch Auto Suppression.
Touch OK.

ot wN-=
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Output Adjustments

Collating Copies

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a
six-page document, the copies are printed in this order:

1,2,3,4,56;1,2,3,4,5,6;1,2,3,4,5,6
Uncollated copies print in the following order:
1,1,1,2,2,2,3,3,3,4,4,4,5,5,5,6,6,6

To select a collating option:

1. At the printer control panel, press the Services Home button.

2. Touch Copy.

3. Touch the Copy tab.

4.  Under Copy Output, select an option.
—  Collated turns on collation for all copies made, regardless of where the originals are placed.
—  Uncollated turns off collation.

Reducing or Enlarging the Image
You can reduce the image to as little as 25 % of its original size or enlarge it as much as 400 % .

To reduce or enlarge the image:
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Copy tab.
4. Under Reduce/Enlarge, touch an option:
— To select a preset image size, touch a button.

— To set the copy size in increments of 1%, touch the + or - buttons or use the keypad to set the
percentage. The default setting is 100 %.
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Printing Multiple Pages per Side

To print multiple pages per side:

1.

&~ wN

At the printer control panel, press the Services Home button.

Touch Copy.

Touch the Output Format tab.

Touch Page Layout.

Touch one of the following:

—  Off: This option copies one original image onto one side of a page.

— Pages Per Side: This option places a defined number of pages on one or both sides of the
paper.

— Repeat Image: This option places a defined humber of the same image on one or both sides of
the paper.

Touch OK.

Adjusting the Edge Erase

ok wh-~

At the printer control panel, press the Services Home button.
Touch Copy.

Touch the Layout Adjustment tab.

Touch Edge Erase.

Select the desired edge, then to adjust, touch the (+) or (-) button.
Touch OK.
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Scanning

This chapter includes:

104

Basic Scanning
Scanning to a USB Flash Drive

107

Scanning to a Shared Folder on a Network Computer

..108

Scanning to an Email Address

111

112

Scanning to Web Services on Devices
Scanning Images into an Application on a USB Connected Computer
Adjusting Scanning Settings

..113

115

See also:
I[nstallation and Setup Overview on page 32
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Basic Scanning

The Scanning feature provides several methods for scanning and storing an original document. The
scanning procedure using your printer differs from that of desktop scanners. The printer is connected
typically to a network rather than a single computer, so you select a destination for the scanned image
at the printer.

The printer supports the following scanning functions:

e Scan documents and store images on the printer hard drive.

e Scan original documents to a document repository on a network server.
e  Scan original documents to an email address.

e Scan original documents to your home directory.

e  Scan original documents to a USB Flash drive.

Notes:

e  The printer must be connected to a network to retrieve a scan file remotely.

e  Print, copy, and fax jobs can print while you are scanning original documents or downloading
files from the printer hard drive.

e  For detdils, see the Help in CentreWare Internet Services.

To scan an image:
1. On the control panel, press the yellow Clear All button to clear previous settings.
2. Load your original documents:

—  Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the document
glass.

—  Use the document feeder for multiple or single pages. Remove any staples and paper clips from
the pages and place them face up in the document feeder.

Press the Services Home button, then touch Workflow Scanning.
Touch the Down arrow, then select the template group from the menu.
Select a template from the list.

To change scan settings, touch the appropriate buttons.

No v Ww

Press the green Start button.

Note: To pause the job, press the Stop button. On the touch screen, touch Resume Scanning to
continue the job, or Cancel Scanning to cancel the job completely. If you do not make a selection
within 60 seconds, the job automatically resumes.
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Document Glass

e Lift the document feeder cover and place the
first page face down in the upper left corner of
the document glass.

o Align the originals to the matching paper size
printed on the edge of the glass.

e The document glass accommodates original
sizes up to 216 x 356 mm (8.5 x 14in.).

Document Glass Guidelines

The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.).

To copy or scan the following types of originals, use the document glass rather than the duplex
automatic document feeder.

e  Paper with paper clips or staples attached

e  Paper with wrinkles, curls, folds, tears, or notches

o  Coated or carbonless paper or items other than paper such as cloth or metal

e Envelopes

e  Books

Document Feeder

e Insert originals face up, with page one on top.

e The confirmation indicator illuminates when
you load the originals correctly.

e Adjust the paper guides so they fit against the
originals.

e The document feeder supports paper weights
of 50-125 g/m?for 1-sided pages, and
60-125 g/m?for 2-sided pages.

e The document feeder supports paper sizes
from 139.7 x 139.7 mm (5.5x5.5 in.)
through 215.9 x 355.6 mm (8.5x 14 in.).

e The maximum document feeder capacity is
approximately 60 sheets of 80 g/m? paper.
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Duplex Automatic Document Feeder Guidelines

When loading originals into the duplex automatic document feeder, follow these guidelines:

e Insert originals face up with the top of the page entering the feeder first.

e  Only place loose sheets of paper in the duplex automatic document feeder.

e Adjust the paper guides so that they fit against the originals.

e  Only Insert paper in the duplex automatic document feeder when ink on the paper is dry.
e Do not load originals above the MAX fill line.
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Scanning to a USB Flash Drive

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function
produces scans in .jpg, .pdf, and .tiff file formats.

To scan to a USB Flash drive:

Note: Before pressing the Scan button or inserting the USB Flash drive, press the Power Saver
button, then wait until the Power Saver indicator turns off.

1. Load the original on the document glass or in the duplex automatic document feeder.

2. Insert your USB Flash drive into the USB port on the side of the printer.
The USB Drive Detected message appears on the touch screen.

3. Touch Scan to USB.

4. To change scan settings, touch the appropriate buttons. For details, see Adjusting Scanning Settings
on page 115.

5. Touch the Workflow Scanning tab.
6. To change the file name, touch File Name, type the name, then touch OK.
7. Toselect afile format:
e Touch the Filing Options tab, then touch File Format.
Touch an option, then touch OK.
8. To begin the scan, press Start.

/N WARNING: Do not remove the USB Flash drive until prompted. If you remove the Flash drive before
the transfer is complete, the file can become unusable and other files on the drive can be damaged.
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Scanning to a Shared Folder on a Network
Computer

This section includes:

o  Sharing a Folder on @ WinAOWS COMPULET ... vvriemrirrrinrrississessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssseses
e Sharing a Folder Using Macintosh OS X Version 10.7 and LOter......eeonrcesneeeseeeeneseeseessssssessseseens
e Adding a Folder as an Address Book Entry Using CentreWare Internet Services ......ccccoveeeeneeennecenn.
e Scanning to a Folder on a NetWOrk COMPULET .........vvrverrerrenreisressseesssessesssessssssssssssssssssssssssssssssssssssssssssssseses

Before using the printer as a scanner on a network, you must:
1. Create a shared folder on your computer hard drive.

2. Create an address using CentreWare Internet Services or the Address Book Editor pointing the
scanner to the computer.

Note: For more information, see Connecting the Printer on page 34.

Sharing a Folder on a Windows Computer

Open Windows Explorer.

Right-click the folder you want to share, then select Properties.

Click the Sharing tab, then click Advanced Sharing.

Select Share this folder.

Click Permissions.

Select the Everyone group, and verify that all permissions are enabled.
Click OK.

NowuEsWwN-~

Note: Remember the Share name for later use.

Click OK again.
9. Click Close.

®
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Sharing a Folder Using Macintosh OS X Version 10.7 and Later

NN =

From the Apple menu, select System Preferences.

From the Internet & Wireless menu, select Sharing.

From the Service menu, select File Sharing.

Under Shared Folders, click the plus icon (+).

Browse to the folder that you want to share on the network, then click Add.

To modify access rights for your folder, select it. The groups activate.

From the Users list, click Everyone, then use the arrows to select Read & Write.

Click Options.

To share the folder with Windows computers, select Share files and folders using SMB.
To share the folder with specific users, next to the user name, select On.

. Click Done.
. Close the System Preferences window.

Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder
and subfolders.

Adding a Folder as an Address Book Entry Using CentreWare Internet
Services

1.

W e NSO EWN
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o

11.

12.

13.

At your computer, open a Web browser, in the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer
on page 28.

Click Address Book.

Click Add.

For Scan To Destination, click Add Destination.

For Nickname, type a name. This field is required.

From the Protocol menu, select SMB.

For Host Address, type the IP address or DNS name for the server.

For Port Number, enter the default port number, or select a number from the range provided.

For Name of Shared Directory, type the name of the destination folder on the FTP server. For
example, to save scanned files to a shared folder named scans, type scans.

. For Subdirectory path, type the path of the folder as needed. For example, to save scans to a folder

called colorscans that is one level below the scans folder, type /colorscans.

Type the Login Name that you use to access this computer. The printer uses this login name to
access the shared folder.

To access the shared folder on the remote computer to save scanned files, for Password, type and
confirm the password.

Click Save.
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Scanning to a Folder on a Network Computer

1. Load the original on the document glass or in the duplex automatic document feeder.

2. Atthe printer control panel, press the Services Home button.

3. On the printer control panel, touch Scan to.

4. Touch Network.

5. Touch the address book entry.

6. Touch OK.

7. To change scan settings, touch the appropriate buttons. For details, see Adjusting Scanning Settings
on page 115.

8. To change the file name, touch File Name, type the name, then touch OK.

9. Toselect afile format:
e Touch the Filing Options tab, then touch File Format.
Touch an option, then touch OK.
10. To begin the scan, press Start. The printer scans your image to the folder you specified.
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Scanning to an Email Address

Before scanning to an email address, set up the printer up with the email server information. For details,
see the System Administrator Guide at www.xerox.com/office/WC3655docs.

To scan an image and send it to an email address:

1. Load the original on the document glass or in the duplex automatic document feeder.
2. Press the Services Home button, then touch Email.

3.  Touch the Email tab.

4. Specify the method for selecting recipients:

— New Recipient: Allows you to enter the email address manually. To enter the address, use the
keypad.

—  Favorites: Allows you to select from the Device Address Book.
—  Network Address Book: Allows you to select an email address from the network address book.
5. When you are finished, touch Close.
6. Toadd a subject line:
e  Touch Subject, then use the touch screen keyboard to type the desired text.
Touch OK.
7. Toadd a message:
e  Touch the Email Options tab.
Touch Message.
Type the Message text for the body of the email.
Touch OK.
8. Toselect afile format:
e  Touch the Email Options tab.
Touch File Format.
Touch an option, then touch OK.
9. To change the file name, touch File Name, type the name, then touch OK.

10. To change scan settings, touch the appropriate buttons. For details, see Adjusting Scanning Settings
on page 115.

11. To begin the scan, press the Start button.
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Scanning to Web Services on Devices

Web Services on Devices (WSD) connect your computer to the printer. Use WSD to access scanned
images at your computer.

Note: See Installing the Printer as a Web Service on Devices.

To scan to WSD:

1. Load the original on the document glass or in the duplex automatic document feeder.
2. On the printer control panel, touch Scan to.

3. Touch WSD.

4, To select a destination, touch the computer address.

5. Toselect the scan type, touch the Event field, then touch the scan type.

6. To begin the scan, press Start.

7. At the computer WSD Scan Device message, select a program to complete the scan.
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Scanning Images into an Application on a USB
Connected Computer

This section includes:

e  Scanning an Image into an APPLCALION ...ttt ssssssssssssssssssssssssssssssssssssssssssssseses 113
o Scanning an ImMage USIiNg WINAOWS XP ...t eessessesssssssssssssssssessssssssssssssssssssssssssssssseses 113
e Scanning an Image Using Windows Vista or WINAOWS 7 ........coeecenmeeenneeennecessseeessesssseessessssssesssseenns 114

You can import images directly from the scanner into a folder on your computer. With a Macintosh
computer, and some Windows applications, you can import the images directly into an application.

Scanning an Image into an Application
Note: Some Windows applications, including Office 2007, do not support this feature.

Open the file to insert the image.

In the file, select the insertion point for the image.

From the Windows toolbar, click Image>Picture>From Scanner or Camera.
From the Insert Image from Camera or Scanner window, select your device.
Click Custom Insert.

From the Basic Scanning tab, for Scan From, select an option.

To change any of the scanning settings, select them as needed.

To adjust crop lines, select Preview as needed.

Click Scan.

The printer scans the document and places the image in your application.
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Scanning an Image Using Windows XP

On your computer, select Start>Control Panel.

On your computer, click Start>Settings>Control Panel>Printer and Other Hardware.
Double-click Scanners and Cameras.

In the Scanners and Cameras window, click Next.

Double-click Xerox WC3655.

Select an option:
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—  Color picture

—  Grayscale picture

—  Black and white picture or text
—  Custom
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10.
11.
12.
13.
14.
15.
16.
17.

Select the paper source:

—  Document Glass

— Document Feeder

To preview the document or select a portion of the document to scan, select Preview.
The printer scans a preview copy of the image.

To select a portion of the document to scan, click and drag the corner points to resize the frame.
Click Next.

Type a name for this group of pictures.

Select a file format.

Type a path name or browse to a location for the scanned images.

To save your image to the folder, in the Other Options window, select Nothing.

Click Next.

To view the scanned image, click the folder link in the window.

Click Finish.

The image is stored in the folder and ready for use in your applications.

Scanning an Image Using Windows Vista or Windows 7
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On your computer, select Start>All Programs>Windows Fax and Scan.

Click New Scan.

If prompted, select Xerox <ProdID>, then click OK.

Select the scan settings.

To preview the document or select a portion of the document to scan, select Preview.

The printer scans a preview copy of the image.

To select part of the document, clear Preview or scan images as separate files, then to resize the
frame, use the corner points.

Click Scan.

The scanned image is stored in the default Scanned Documents folder or in a folder that you
selected.
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Adjusting Scanning Settings

This section includes:

®  SEttiNg the OULPUL COlOT e e s s ssssssssssssssssssssssessssssssessssssssesssssssssssssessssssssssssssssnees 115
o Setting the SCON RESOIULION ...ttt ssss e ssss s ssssess s ssss s ssss s s ssssse s ssssesssssesses 116
o Selecting 2-Sided SCANNING ...t sssssssssssssssssssssssssssssssssssssssssssssssssssssnssssssssssssssssssssssssssnsssnnses 116
®  SEttiNg the File FOMMIOL.. ettt sssss st ssssssss s s ssssssssssasessssssssssssssssssssssnsssnees 116
o Making the IMAge LIGhter OF DATKET ... sssssesssssssssssssssessssssssssssssssessssssssssssssssessssesses 116
®  AdJUSEING The SNAMPNESS ...ttt ssssssssss s s s s sssssssssssssssssss s sssnsssssssssssssssssssssssssssssansssness 117
®  AdJUSEING The CONTIAST....ooreiereeeeeereeeeiseeeeississsstssssssstsssssss s sssssssessssssssssssssssssasssssssssssssssssassssssssessssasssssssssssssssnes 117
e Automatically Suppressing Background VAriation ..........ccoceoeenreenneienseesnesesssssssssssssessssssssssssssssesssssesees 117
o SPECifYiNG the OriQINGL SIZE ...t ssessssss s s s s ssssssssssssssssssssssssssssssssssssssssssssssssssssnsssnes 117
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You can modify the scan settings for individual jobs, once you select the scan mode.

You can also change the default values of some settings. For details, see Changing the Default Scan
Settings.

Setting the Output Color

If the original image contains color, you can scan the image in color or in black and white. Selecting
black and white significantly reduces the file size of the scanned images.

To set the output color:

1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.

3.  Touch Output Color.

4. Select a color mode.
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Setting the Scan Resolution

The scan resolution depends on how you plan to use the scanned image. Scan resolution affects both
the size and image quality of the scanned image file. Higher scan resolution produces better image
quality and a larger file size.

To set the scan resolution:

1. At the printer control panel, press the Services Home button.
Touch Scan To, then select an option.

Touch the Advanced Settings tab, then touch Resolution.
Select an option.

Touch OK.
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Selecting 2-Sided Scanning
2-Sided Scanning scans both sides of the original image.

To set 2-sided scanning:

1. At the printer control panel, press the Services Home button.

Touch Scan To, then select an option.

Touch 2-Sided Scanning.

Touch 2-Sided.

To rotate the image on side 2 by 180 degrees, touch 2-Sided, then touch Rotate Side 2.
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Setting the File Format

At the printer control panel, press the Services Home button.
Touch Scan To, then select an option.

Touch the Filing Options tab, then touch File Format.
Touch an option, then touch OK.
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Making the Image Lighter or Darker

At the printer control panel, press the Services Home button.

Touch Scan To, then select an option.

Touch the Advanced Settings tab.

Touch Image Options.

To lighten or darken the image, for Lighten/Darken, move the slider up or down.
Touch OK.
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Adjusting the Sharpness

At the printer control panel, press the Services Home button.
Touch Scan To, then select an option.

Touch the Advanced Settings tab.

Touch Image Options.

For Sharpness, move the slider up or down.

Touch OK.
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Adjusting the Contrast

1. Press the Services Home button, then touch Scan To.
2. Touch the Advanced Settings tab, then touch Image Enhancement.
3. Onthe Image Enhancement screen, select an option:
— Auto Contrast: To enable the printer to set the contrast automatically, select this option.

—  Manual Contrast: To adjust contrast manually, select this option. To increase or decrease the
contrast, move the Manual Contrast slider up or down.

4. Touch OK.

Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can be
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to
variations in light background colors.

To select Auto Suppression:

1. Touch OK.

2. Touch the Advanced Settings tab, then touch Image Enhancement.
3. Under Background Suppression, touch Auto Suppression.

4. Touch OK.

Specifying the Original Size

At the printer control panel, press the Services Home button.
Touch Scan To, then select an option.

Touch the Layout Adjustment tab.

Touch Original Size, then select an option.
Touch OK.
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Erasing Edges

You can specify an amount of space to erase from the edges of your scans.

To use Edge Erase:

1.

i s wN
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At the printer control panel, press the Services Home button.
Touch Scan To, then select an option.

Touch the Layout Adjustment tab.

Touch Edge Erase.

To change the Edge Erase settings, select an option.

— All Edges: Erases all four edges by the same amount. To specify the amount to erase from the
edges, click the All Edges arrows.

— Individual Edges: This option specifies different amounts to erase from the edges. Touch
Side 1, then to specify the amount to erase from each edge, use the arrows. Touch Side 2,
then to specify the amount to erase from each edge, use the arrows or touch Mirror Side 1.

Touch OK.
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This chapter includes:

o  Configuring the Printer for FAXiNG .....coinnrinsrinsinssinssessssenssssssessssennes e 120
®  BOSIC FOXINGuitirirrrrireieseinssesstssssss st ssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssnssssssssssssssssssssasssssses 122
o Sending an EMDEAAEA FOX ..o eeeesse s sssssssssessssssssssssssssssssssssssssssassssssessens 123
o Selecting FAX OPLiONS......ooveerveereerresesisssissssesssisssesssssssssssssssssssssssssssssssesssses e 125
®  SENAING O SEIVET FOAX cvtrrriretereeesceessesssisssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssnssssssssssssssssssssssssssssssnsssssssssssssssssanses 133
®  SeNAING AN INEEMNET FOX weriierieeeeeeceeeceee e ssasesssssssssesssssssssssssssesssssssssssessssesssssesssssessssssssssesssssesssssssssesssssesses 137
e Sending a LAN Fax 143
®  USING The AAAIESS BOOK...... e sassssisssssss s ssssssssessssssssssssssssssssssssssssssssssssssssessssssassssssssssssssssssssssseses 144

The system administrator must set up this feature before you can use it. For details, see the System
Administrator Guide at www.xerox.com/office/WC3655docs.
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Configuring the Printer for Faxing

Before you use the fax, you must configure the Fax Settings to make it compatible with your local
connection and regulations. The Fax Settings include optional features you can use to configure the
printer for faxing.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or driver type.

For details, see the System Administrator Guide at www.xerox.com/office/WC3655docs.

Document Glass

e Lift the document feeder cover and place the
first page face down in the upper left corner of
the document glass.

e Align the originals to the matching paper size
printed on the edge of the glass.

e The document glass accommodates original
sizes up to 216 x 356 mm (8.5 x 14in.).

Document Glass Guidelines
The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.).

To copy or scan the following types of originals, use the document glass rather than the duplex
automatic document feeder.

e  Paper with paper clips or staples attached

e  Paper with wrinkles, curls, folds, tears, or notches

e  Coated or carbonless paper or items other than paper such as cloth or metal
e  Envelopes

e  Books
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Document Feeder

o Insert originals face up, with page one on top.

e The confirmation indicator illuminates when
you load the originals correctly.

e Adjust the paper guides so they fit against the
originals.

e The document feeder supports paper weights
of 50-125 g/m? for 1-sided pages, and
60-125 g/m?for 2-sided pages.

e The document feeder supports paper sizes
from 139.7 x 139.7 mm (5.5 x 5.5 in.)
through 215.9 x 355.6 mm (8.5x 14 in.).

e The maximum document feeder capacity is
approximately 60 sheets of 80 g/m? paper.

Duplex Automatic Document Feeder Guidelines

When loading originals into the duplex automatic document feeder, follow these guidelines:

e Insert originals face up with the top of the page entering the feeder first.

e  Only place loose sheets of paper in the duplex automatic document feeder.

e  Adjust the paper guides so that they fit against the originals.

e  Only Insert paper in the duplex automatic document feeder when ink on the paper is dry.
e Do not load originals above the MAX fill line.

Xerox® WorkCentre® 3655 Multifunction Printer 121
User Guide



Faxing

Basic Faxing

You can send a fax in one of four ways:
e  Fax, or embedded fax, scans the document and sends it directly to a fax machine.

e Server Fax scans the document and sends it to a fax server, which transmits the document to a fax
machine.

e Internet Fax scans the document and emails it to a recipient.
e LAN Fax sends the current print job as a fax. For details, see the print driver software.

To send a fax:
1. Load your original documents:

—  Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the document
glass.

—  Use the document feeder for multiple or single pages. Remove any staples and paper clips from
the pages and place them face up in the document feeder.

2. Press the Services Home button, then touch the appropriate fax.
3. Address the fax using one or more of the available options:

—  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

— Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use
the touch screen keypad to enter the numerals and characters, then touch Save.

Note: One or more dialing pauses can be required between the access number for an outside line
and the fax number. When inserted, the dial pauses appear as commas in the fax number.

—  Favorites allows you to access selected favorite individual or group contacts from the address
book.
— Address Book allows you to access the printer address book.
4. Onthe Fax tab, adjust the available fax options as needed.

5. Adjust additional fax options as needed. For details, see Selecting Fax Options on page 125,
Selecting Server Fax Options on page 134, or Selecting Internet Fax Options on page 139.

6. Press the green Start button. The printer scans the pages and transmits the document when all
pages have been scanned.
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Sending an Embedded Fax

Load the original on the document glass or in the duplex automatic document feeder.
Press the Services Home button, then touch Fax.

Touch the Fax tab.

To address the fax, touch one or more options.
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—  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

— Dialing Characters allows you to insert characters such as a dial pause in a fax number. Use
the touch screen keypad to enter the numerals and characters, then touch Add. Add more
numbers, or touch Close.

Note: One or more dialing pauses can be required between the access number for an outside line
and the fax number. When inserted, the dial pauses appear as commas in the fax number.

—  Favorites allows you to access selected favorite individual or group contacts from the address
book.

—  Device Address Book: You can use this option to select fax numbers from your Device Address
Book. Touch the Down arrow, then select a contact list from the drop-down menu. Touch the
desired contact, then select Add to Recipients. Select and add more contacts, or touch Close.

5. Toinclude a fax cover sheet:

e  Touch Cover Sheet>On.
Touch the To field, use the touch screen keyboard to type the name of the recipient, then touch OK.
Touch the From field, use the touch screen keyboard to type the name of the sender, then touch OK.
To add or modify a comment, do one of the following:

e  Touch an existing comment, then touch OK. To finalize your cover sheet selections, touch
OK.

e  Touch an <Available> comment, touch the Edit icon, use the touch screen keyboard to
type the text, then touch OK. To finalize your cover sheet selections, touch OK.

e To delete an existing comment, touch the comment, then touch the Delete icon. To
confirm the action, touch Delete.

e To edit an existing comment, touch the comment, then touch the Edit icon. To change the
comment, use the touch screen keyboard, then touch OK.
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Touch 2-sided Scanning and select an option.

Touch Original Type and select an option.

Touch Resolution and select an option.

Select more options as needed. For details, see Selecting Fax Options on page 125.

0. Press the green Start button. The printer scans the pages and transmits the document when all
pages have been scanned.

i

Note: To pause the job, press the Stop button. On the touch screen, touch Resume Scanning to
continue the job, or Cancel Scanning to cancel the job completely. If you do not make a selection
within 60 seconds, the job automatically resumes.
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Selecting Fax Options

This section includes:
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®  SENAING HEAAET TOXL..oerieeeieeeiseeesseensiesesssssesssssssssssssssssssssssssssssssssssssssssssessssssssesssssssssssssssssssssssssssssssssssssssssssssssssssnees 128
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o Storing A FAX iN @ LOCAL MAIIDOX w..uuvverierieriersiessisssessienssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssseses 129
o Printing LOCAl MilDOX DOCUMENLS.......couieemeeeiecemrecimeceieeeessesissesissseesssesesssetasssessssesssssesesssessasesssasesesssessasssssasasssns 129
o Deleting LOCAl MAIIDOX DOCUMENLS ......ooeeereeeeeereeeseessesssessssessssssssssesssssssssssssssesssssssssssssssssssssesssssssssssssssessens 130
o  Storing a Fax for Local or REMOLE POIlING ........cuevereereieereieseeesssessseesssssssssssssssssssssessssssssssssssssessssssssssnessens 130
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Adjusting Brightness and Sharpness

You can lighten or darken the image, and adjust the sharpness.

To adjust the image:
1. Press the Services Home button, then touch Fax.
2. Touch the Image Quality tab, then touch Image Options.
3. Onthe Image Options screen, adjust the sliders as needed:
— Lighten/Darken lightens or darkens the image.
—  Sharpness sharpens or softens the image.
4.  Touch OK.
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Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can be
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to
variations in light background colors.

To select Auto Suppression:

1. Press the Services Home button, then touch Fax.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. Under Background Suppression, touch Auto Suppression.

4, Touch OK.

Adjusting the Contrast

Contrast is the relative difference between light and dark areas in an image.

To adjust the contrast:

1. Press the Services Home button, then touch Fax.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. Onthe Image Enhancement screen, select an option:

—  Manual Contrast allows you to adjust the contrast manually. Under Manual Contrast, move
the slider up or down to increase or decrease the contrast. The middle position on the slider,
Normal, does not change the contrast.

—  Auto Contrast allows the printer to set the contrast automatically.
4. Touch OK.

Specifying the Size of the Original
To ensure that you are scanning the correct area of the documents, specify the original size.

To specify the original size:
1. Press the Services Home button, then touch Fax.
2. Touch the Layout Adjustment tab, then touch Original Size.
3. On the Original Size screen, select an option:
—  Auto Detect: This options allows the printer to determine the size of the original.

Note: The Auto Detect option is enabled only when the original is loaded in the duplex automatic
document feeder.

—  Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

—  Custom Scan Area allows you to specify the height and width of the area to scan. To specify
an areaq, touch the Length (Y) and Width (X) arrows.

4. Touch OK.
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Selecting Reducing or Splitting

You can determine the method to use for handling images that are too large.

To select reducing or splitting:

1.
2.
3.

Press the Services Home button, then touch Fax.

Touch the Layout Adjustment tab, then touch Reduce/Split.

Touch an option:

—  Reduce to Fit shrinks large documents to fit on smaller paper.

—  Split Across Pages continues a single image across several pages.
Touch OK.

Setting Up Book Faxing

You can determine the method used for scanning images in a book.

To select book faxing:

1.
2.
3.

Press the Services Home button, then touch Fax.

Touch the Layout Adjustment tab, then touch Book Faxing.

Touch an option:

—  Offis the default setting.

—  Both Pages scans both pages of the book.

—  Left Page Only scans the left page of the book.

— Right Page Only scans the right page of the book.

To set the amount to erase, touch the Binding Edge Erase arrows as needed.
Touch OK.

Printing a Confirmation Report

You can print a report that confirms when your faxes are sent or received. The report contains
information on timeouts, busy signals, and retry failures.

To set up a confirmation report printing:

1.
2.
3.

Press the Services Home button, then touch Fax.

Touch the Fax Options tab, then touch Confirmation Report.

Touch an option:

—  Print Confirmation: This option generates a report for all fax jobs.

—  Print on Error Only: This option generates a report only for fax jobs that fail to send.
Touch OK.
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Selecting the Starting Rate

Select the highest starting rate unless the destination for the fax you are sending has special
requirements.

To select the transmission speed for a fax:

1.  Press the Services Home button, then touch Fax.

2. Touch the Fax Options tab, then touch Starting Rate.
3. Touch an option.

4. Touch OK.

Note: Some telephone networks can require you to set the fax starting rate to Forced (4800 bps).
The slower data rate ensures a more reliable transmission of data.

Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. The delay can range from 15
minutes through 24 hours.

Note: Before using this feature, set the printer to the current time.

To specify the time to send your fax:
1. Press the Services Home button, then touch Fax.
2. Touch the Fax Options tab, then touch Delay Send.
3. Touch Delay Send.
4. Touch Specified Time.
—  Touch the Hour field, then touch the arrows to set a number.
—  Touch the Minute field, then touch the arrows to set a number.
—  If your printer is set to display the 12-hour clock, touch AM or PM.
5. Touch OK.
The fax is scanned and saved, then sent at the specified time.

Sending Header Text

The system administrator must set up this feature before you can use it. For details, see the System
Administrator Guide at www.xerox.com/office/WC3655docs.

To include the fax header text:

1. Press the Services Home button, then touch Fax.

2. Touch the Fax Options tab, then touch Send Header Text.
3. Touch On.

4. Touch OK.
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Sending a Fax to a Remote Mailbox

Press the Services Home button, then touch Fax.
Touch the Fax Options tab, then touch Mailboxes.
Touch Send to Remote Mailbox.

s whnN 2

To address the fax, select an option:

—  Fax Number: You can use this option to enter a fax number. Touch Enter Fax Number, use the
alphanumeric keypad to enter the number, then touch OK.

— Dialing Characters: You can use this option to insert characters such as a Dial Pause in a fax
number. To enter the numerals and characters, use the touch screen keypad, then touch OK.

5. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number.
6. Touch OK.
7. Press the Start button.

Storing a Fax in a Local Mailbox

The system administrator must create a mailbox before you can use this feature. For details, see the
System Administrator Guide at www.xerox.com/office/WC3655docs.

To store a fax in a local mailbox:
1. Press the Services Home button, then touch Fax.

2. Touch the Fax Options tab, then touch Mailboxes.

3. Touch Store to Local Mailbox.

4. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number.

5. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit
mailbox passcode.

6. Touch OK.

Printing Local Mailbox Documents

To use this feature, you must have documents stored in a mailbox. For details, see Storing a Fax in a
Local Mailbox on page 129.

To print local mailbox documents:

1. Press the Services Home button, then touch Fax.

Touch the Fax Options tab, then touch Mailboxes.

Touch Print Local Mailbox Documents.

Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number.

Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit
mailbox passcode.

i & WwhN

6. Touch Print All Documents. The documents in the mailbox are printed.
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Deleting Local Mailbox Documents
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Press the Services Home button, then touch Fax.

Touch the Fax Options tab, then touch Mailboxes.

Touch Delete Local Mailbox Documents.

Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number.

Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit
mailbox passcode.

Touch Delete All Documents.
To confirm, touch Delete All. All documents in the mailbox are deleted.

Storing a Fax for Local or Remote Polling

Turn on Secure or Non-Secure Local Polling to make fax documents stored on one printer available for
remote polling by other printers. When Secure Local Polling is on, you create a list of fax numbers that
are allowed to access the stored faxes on the printer.

To store a fax:

1.
2.
3.

130

Press the Services Home button, then touch Fax.
Touch the Fax Options tab, then touch Local Polling.
For Store for Local Polling, touch an option.

— Non-Secure Polling: You can use this option to scan your originals and store them as
documents. Anyone with this fax number can access the documents.

—  Secure Polling: You can use this option to scan your originals and store them as documents.
You specify the fax numbers that can access the documents.

For secure polling, to add fax numbers to the access list, touch one or more of the following options:

—  Fax Number: You can use this option to enter a fax number. To enter the number, use the
alphanumeric keyboard, then touch + to add the number.

— Device Address Book: You can use this option to select fax numbers from your Device Address
Book. Touch the Down arrow, then select a contact list from the drop-down menu. Touch the
desired contact, then select Add to Recipients. Select and add more contacts, or touch Close.

—  Allow all Address Book fax numbers access: You can use this option to add all stored fax
numbers to the list.

Note: To modify existing entries in the access list, touch the entry, then select Edit, Remove, or
Remove All from the drop-down menu.

Touch OK.
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Printing or Deleting Stored Faxes

1. Press the Services Home button, then touch Fax.
2. Touch the Fax Options tab, then touch Local Polling.
3. For Store for Local Polling, touch an option.
—  Print All Stored Documents: This option prints all fax documents stored in the printer.

—  Delete All Stored Documents: This option deletes all fax documents stored in the printer. To
confirm the action, touch Delete All.

Polling a Remote Fax

If remote polling is turned on, you can retrieve documents that were stored using local polling on
another fax machine.

Note: If Local Polling is turned on, Remote Polling is not available. To turn off Local Polling, touch
Local Polling>Off>Save.

To poll a remote fax:

1. Press the Services Home button, then touch Fax.

2. Touch the Fax Options tab, then touch Remote Polling.
3. ForPoll, touch Remote Fax.

4. Select one or more options.

—  Enter Number: You can use this option to enter a fax number manually. To enter the number,
use the alphanumeric keyboard, then touch + to add the number.

— Dialing Characters allows you to insert characters such as a dial pause in a fax number. Use
the touch screen keypad to enter the numerals and characters, then touch Add. Add more
numbers, or touch Close.

5. Toset a later time for your printer to retrieve faxes from other fax machines:
e Touch Delay Poll.
To set the time, touch Delay Poll.
e Touch the Hour field, then touch the arrows to set a number.
e  Touch the Minute field, then touch the arrows to set a number.
e If your printer is set to display the 12-hour clock, touch AM or PM.
Touch OK.
6. To retrieve and print the faxes, touch Poll Now.

Note: To cancel the operation, touch Close.

Xerox® WorkCentre® 3655 Multifunction Printer 131
User Guide



Faxing

Building a Fax Job

Use this feature to fax an assorted group of originals, each with different settings. Each segment is
programmed and scanned, and the images are stored temporarily in the printer. Once all segments have
been stored, the individual segments are faxed as a single job.

To build a fax job:
1. Press the Services Home button, then touch the appropriate fax.
2. Address the fax using one or more of the available options:

—  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

— Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use
the touch screen keypad to enter the numerals and characters, then touch Save.

— Device Address Book: You can use this option to select fax numbers from your Device Address
Book.

—  Favorites: You can use this option to access and select the individual or group contacts that are
designated as favorites in your Device Address Book.

3. Touch the Job Assembly tab, then touch Build Job>On.
4.  Touch Options.
o  Select or clear the Display Summary window between segments check box.
Select or clear the Turn Build Job Off after Job is Submitted check box.
5. Program and scan the first segment:
e Load the originals for the first segment.
Select the required settings, such as layout adjustments, image quality, and options.
Press the green Start button on the control panel.
6. Program and scan additional segments:
e Load the originals for the next segment.
When the Build Job screen appears, touch Program Next Segment.
Using the appropriate tabs, select the required settings.
Press the green Start button to scan the originals for that segment.
7. Repeat the previous step for each remaining segment.

Note: At any time, you can touch Delete Last Segment or Delete All Segments to modify the job.

8. When all of the segments have been programmed and scanned, touch Submit the Job. The Job
Progress screen appears, and the individual segments are faxed as a single job.

9. Onthe Job Progress screen, touch Job Details to view a summary of the job.

Note: If necessary, touch Delete>Delete Job to cancel the job.
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Sending a Server Fax

If a fax server is connected to the network, you can send a document to a fax machine without requiring
a dedicated telephone line.

When using the server fax, a document is scanned and sent to a fax repository on the network. The fax
server then sends the fax over a telephone line to a fax machine.

The system administrator must enable the server fax service and configure a fax repository, or filing
location, before you can use this feature.

To send a server fax:

1. Load the original on the document glass or in the duplex automatic document feeder.
2. Press the Services Home button, then touch Server Fax.

3. To address the fax, touch one or more options:

—  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

— Dialing Characters allows you to insert characters such as a dial pause in a fax number. Use
the touch screen keypad to enter the numerals and characters, then touch Add. Add more
numbers, or touch Close.

—  Fax Directory allows you to select fax numbers from your Fax Directory. Touch the Up or Down
arrows to scroll through the list, touch the desired contact, then select Add to Recipients from
the drop-down menu. Select and add more contacts, or touch Close.

Touch 2-sided Scanning and select an option.

Touch Original Type and select an option.

Touch Resolution and select an option.

Select more options as needed. For details, see Selecting Server Fax Options on page 134.
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Press the green Start button. The printer scans the pages and transmits the document when all
pages have been scanned.
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Selecting Server Fax Options

This section includes:

®  AQJUSEING BIIGNENESS ...ttt sases e s s s s assbsss st bss s s b s s b ss b s s besss s b s s b ssnsen 134
e Automatically Suppressing Background VAriation .......c..oeeceeceeeeenecesneceseesisseessecessesessseesssesssssessssseens 134
®  AdJUSEING The CONTIAST ..ottt sttt e sss e st b s s s bbbt s s s eees 135
o  Specifying the Orientation Of the OFgINGL..... s sssssesssssssssssssssnses 135
o Specifying the Size Of the OFiGINGL ... sessssss s ssssssssssssssssssssssssssssssssssssssssnsssnses 135
0 SeNAING A DELAYEA FOX .ot eesssssssesssssssssssessssssssssssssssessssssssssesssssesssssassssssssssessssassssessssasssssesssseses 136
®  BUILAING O FOX JOD ottt s sssss s s ssssss s sssssssbssssssssssssssssssssss s sssssssssssnsbssssssnsssssssnnes 136

Adjusting Brightness
You can lighten or darken the image.

To adjust the image:

1. Press the Services Home button, then touch Server Fax.

2. Touch the Image Quality tab, then touch Image Options.

3. Onthe Image Options screen, adjust the Lighten/Darken slider up or down as needed.
4. Touch OK.

Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can be
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to
variations in light background colors.

To select Auto Suppression:

1. Press the Services Home button, then touch Server Fax.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. Under Background Suppression, touch Auto Suppression.

4, Touch OK.
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Adjusting the Contrast
Contrast is the relative difference between light and dark areas in an image.

To adjust the contrast:

1. Press the Services Home button, then touch Server Fax.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. Onthe Image Enhancement screen, select an option:

—  Manual Contrast allows you to adjust the contrast manually. Under Manual Contrast, move
the slider up or down to increase or decrease the contrast. The middle position on the slider,
Normal, does not change the contrast.

—  Auto Contrast allows the printer to set the contrast automatically.
4.  Touch OK.

Specifying the Orientation of the Original

1. Touch the Layout Adjustment tab, then touch Original Orientation.
2. On the Original Orientation screen, touch the desired orientation:

— Upright Images and Sideways Images refer to the direction the originals are loaded in the
document feeder.

—  Portrait Originals and Landscape Originals refer to the images on the originals.

Note: If you are using the document glass, the orientation of the original is as seen before turning it
over.

3. Touch OK.

Specifying the Size of the Original
To ensure that you are scanning the correct area of the documents, specify the original size.

To specify the original size:
1. Press the Services Home button, then touch Server Fax.
2. Touch the Layout Adjustment tab, then touch Original Size.
3. On the Original Size screen, select an option:
—  Auto Detect: This options allows the printer to determine the size of the original.

Note: The Auto Detect option is enabled only when the original is loaded in the duplex automatic
document feeder.

— Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

—  Custom Scan Area allows you to specify the height and width of the area to scan. To specify
an areq, touch the Length (Y) and Width (X)arrows.

4. Touch OK.
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Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. The delay can range from 15
minutes through 24 hours.

Note: Before using this feature, set the printer to the current time.

To specify the time to send your fax:
1. Press the Services Home button, then touch Server Fax.
2. Touch the Fax Options tab, then touch Delay Send.
3. Toselect a delayed transmission time, touch Delay Send.
e  Touch the Hour field, then touch the arrows to set a number.
Touch the Minute field, then touch the arrows to set a number.
If your printer is set to display the 12-hour clock, touch AM or PM.
4. Touch OK.
The fax is scanned and saved, then sent at the specified time.

Building a Fax Job

For details, see Building a Fax Job on page 132.
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Sending an Internet Fax

If an SMTP (email) server is connected to the network, a document can be sent to an email address. This
feature eliminates the need for a dedicated telephone line and the associated service costs. When
sending an Internet Fax, the document is scanned and sent to an email address.

To send an Internet fax:
1. Load the original on the document glass or in the document feeder.
2. Touch the Services Home button, then touch Internet Fax.
3. To address the fax:
e  Touch New Recipient.
Touch the Down arrow, then from the menu, select To: or Cc..

Touch the Enter email address and select Add field, then use the touch screen keyboard to type the
email address.

Touch Add.
Use the touch screen keyboard to type additional email addresses.
When you are finished, touch Close.
4. To add asubject line:
e  Touch Subject, then use the touch screen keyboard to type the desired text.

Note: To modify the default subject that appears, touch X to clear the field.

Touch OK.
5. Adjust the Internet fax options as needed.
e  Touch 2-sided Scanning and select from the drop-down menu:

o 1-Sided
e 2-Sided
e 2-Sided, Rotate Side 2

Touch Original Type and select from the drop-down menu:
e Photo & Text

e Photo
e Text
e Map

o Newspaper/Magazine
Touch File Format, then select from the drop-down menu:

o TIFF
e PDF
o PDF/A
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6. Adjust additional fax options as needed.

7. Press the green Start button. The printer scans all of the pages into a document, then sends the
document as an email attachment in .pdf or .tiff file format.

138 Xerox® WorkCentre® 3655 Multifunction Printer
User Guide



Faxing

Selecting Internet Fax Options

This section includes:

o Adjusting Brightness aNd SHOAMPNESS ........verinerinsiiinsinssisssisssisssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 139
o  Automatically Suppressing Background VAMQEION .........orvvereeenreenneensiensssnssessssssssssssssssssssssssssssssssssssssssses 139
®  AJUSEING Th@ CONLIUSTE....eorceereeeeeeeeceee et sss s sssssssss s sssesssssesssssessss s s s s ss s sssess s s s s enssasesses 140
®  SEEING thE RESOIULION.......eeeeeeeeesses sttt sssss b sss b s s b s s ss b e b s sas s s s s s ssens 140
o Setting the QUALILY AN FIl@ SIZE ...t ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsssnnses 141
e Specifying the Orientation Of the OFigiNGl....... st sssesssssssssssessssssssssssssssesssssssees 141
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Adjusting Brightness and Sharpness
You can lighten or darken the image, and adjust the sharpness.

To adjust the image:
1. Touch the Services Home button, then touch Internet Fax.
2. Touch the Advanced Settings tab, then touch Image Options.
3. Onthe Image Options screen, adjust the sliders as needed:
— Lighten/Darken lightens or darkens the image.
—  Sharpness sharpens or softens the image.
4.  Touch OK.

Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can be
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to
variations in light background colors.

To select Auto Suppression:

1. Touch the Services Home button, then touch Internet Fax.

2. Touch the Advanced Settings tab, then touch Image Enhancement.
3. Under Background Suppression, touch Auto Suppression.

4. Touch OK.
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Adjusting the Contrast
Contrast is the relative difference between light and dark areas in an image.

To adjust the contrast:

1. Touch the Services Home button, then touch Internet Fax.

2. Touch the Advanced Settings tab, then touch Image Enhancement.
3. Onthe Image Enhancement screen, adjust the contrast:

—  Manual Contrast allows you to adjust the contrast manually. Move the slider up or down to
increase or decrease the contrast. The middle position on the slider, Normal, does not change
the contrast.

—  Auto Contrast allows the printer to set the contrast automatically.
4.  Touch OK.

Setting the Resolution

1. Touch the Services Home button, then touch Internet Fax.
2. Touch the Advanced Settings tab, then touch Resolution.
3. On the Resolution screen, touch the desired resolution.
— 72 dpi produces acceptable image quality for onscreen viewing, and the smallest file size.
— 100 dpi produces good image quality for onscreen viewing, and small file size.
— 150 dpi produces good image quality for onscreen viewing, and small file size.
— 200 x 100 dpi produces good image quality, and moderate file size.
— 200 dpi produces good image quality, and moderate file size. This setting is the default.
— 300 dpi produces high image quality, and large file size.
— 400 dpi produces higher image quality, and larger file size.
— 600 dpi produces the highest image quality, and the largest file size.
4. Touch OK.

Note: Check with the system administrator to determine the largest file size that the email system
allows.
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Setting the Quality and File Size

The Quality/File Size option lets you choose from three settings that balance the quality of the image
and the size of the file. Higher quality images result in larger file sizes, which are not ideal for sharing and
transmitting over the network.

To set the Internet fax quality and file size:

1.
2.
3.

Touch the Services Home button, then touch Internet Fax.
Touch the Advanced Settings tab, then touch Quality/File Size.
On the Quality/File Size screen, to select a setting, use the slider.

Note: The settings range from Highest Compression and Smallest File Size to Lowest Compression
and Largest File Size.

Touch OK.

Specifying the Orientation of the Original

1.
2.
3.

Touch the Services Home button, then touch Internet Fax.
Touch the Layout Adjustment tab, then touch Original Orientation.
On the Original Orientation screen, touch the desired orientation:

— Upright Images and Sideways Images refer to the direction the originals are loaded in the
document feeder.

—  Portrait Originals and Landscape Originals refer to the images on the originals.

Note: If you are using the document glass, the orientation of the original is as seen before turning it
over.

Touch OK.

Specifying the Size of the Original

To ensure that you are scanning the correct area of the documents, specify the original size.

To specify the original size:

1.
2.
3.

Touch the Services Home button, then touch Internet Fax.

Touch the Layout Adjustment tab, then touch Original Size.

On the Original Size screen, select an option:

—  Auto Detect: This options allows the printer to determine the size of the original.

Note: The Auto Detect option is enabled only when the original is loaded in the duplex automatic
document feeder.

— Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

—  Custom Scan Area allows you to specify the height and width of the area to scan. To specify
an areq, touch the Length (Y) and Width (X) arrows.

Touch OK.
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Adding a Message

1.  Touch the Services Home button, then touch Internet Fax.
2. Touch the Internet Fax Options tab, then touch Message.
3. Type a message using the touch screen keyboard.

4.  Touch OK.

Specifying a Reply To Address
1. Touch the Services Home button, then touch Internet Fax.
Touch the Internet Fax Options tab, then touch Reply To.

2
3. Type an email address using the touch screen keyboard.
4. Touch OK.

Printing an Acknowledgment Report

If the status of each recipient is known, you can print a delivery status report. The printer waits for a
delivery receipt from each recipient, then prints the report.

Note: The report could be delayed depending on the response time of the recipients.
To print an acknowledgment report:
1. Touch the Services Home button, then touch Internet Fax.

Touch the Internet Fax Options tab, then touch Acknowledgment Report.

2.
3. Touch Print Report.
4. Touch OK.

Building a Fax Job

For details, see Building a Fax Job on page 132.
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Sending a LAN Fax

Local Area Network (LAN) Fax allows you to send faxes from the print driver on your computer to a fax
machine over a telephone line. The Fax window allows you to enter recipients, create a cover page with
notes, and set options. Using the options you can select confirmation sheets, send speed, fax resolution,
send time, and fax dialing options.

Notes:

o  When the Fax job type is selected, some features, such as Edge Enhancement, Thin Line
Enhancement, and Black Enhancement, are turned off.

¢ Not all printer models support this feature.

To send a LAN fax:

1. With the desired document or graphic open in your application, open the Print dialog box. For most
software applications, click File>Print or press CTRL+P.

Select your printer, then click Properties to open the print driver dialog box.
On the Printing Options tab, from the Job Type list, select Fax.
Click Recipients.
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Do one or more of the following:

—  Click the Add From Phonebook button, then select a phonebook from the list. Select a name
from the upper list, then add it to the Fax Recipients. To add more names, repeat the
procedure. Click OK.

—  Click the Add Recipients button, type the recipient name and fax number, add other
information, then click OK. Add new recipients as needed.

6. Toinclude a cover sheet, click Cover Sheet, then from the Cover Sheet Options list, select Print a
Cover Sheet.

7. On the Cover Sheet information tab, type notes that you want to appear on the cover sheet.
8. Click the Image tab.

9. From the Watermark list, select Custom, then click OK. For details, see Printing Watermarks.
10. On the Options tab, select the options for this fax.

11. Click OK.

12. In the Printer Properties window, click OK.

13. Ensure that the recipient names and fax numbers are correct, then click OK.
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Using the Address Book

This section includes:
e Adding an Individual Entry to the Device Address BOOK............crerrennrinseinssesesssssssesssessssssssssssssssseses 144
e Editing or Deleting Favorites in the Device Address BOOK.........oeoeriereennennensiesieesiessessss s ssssesssens 145

Adding an Individual Entry to the Device Address Book

The Device Address Book can contain up to 5000 contacts. If the Add button is unavailable, the address
book has reached its limit.

Before you can use this feature, the system administrator must enable Create/Edit Contact from Touch
Screen for All Users.

To add a recipient to the Device Address Book:

1. At the printer control panel, press the Services Home button.

2. Toadd an Internet fax or email entry, touch E-mail or Internet Fax.
3. Touch New Recipient.
4

Touch the Enter email address and select Add field, then use the touch screen keyboard to type
the email address.

5. Toadd the recipient to the address book, touch Create New Contact. The Create New Contact icon
appears as a blue book with a green plus (+) sign.

6. Touch Create New Contact.
7. To enter contact information, do one or more of the following:
—  Enter the name to display in the address book.

—  To add name and company information for the new entry, to the right of the contact field,
touch the i button. For the First Name, Last Name, or Company fields, enter a name, then touch
OK.

— To enter a fax number for the contact, to the right of the green fax icon, touch the field. To
enter the number, use the alphanumeric keyboard.

— To enter an Internet fax number for the contact, to the right of the blue Internet Fax icon,
touch the field. To enter the number, use the alphanumeric keyboard.
Notes:

e  The first entry into one of the fields becomes the display name for the contact information.
e  The email address that you previously entered is displayed to the right of the email icon.

8. To mark a contact as a favorite, to the right of the global address book, email, fax, or Internet fax
fields, touch the corresponding star.

9. To save the contact to the Device Address Book, touch OK.
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To add a recipient to the Device Address Book using the Fax feature:

1.

2.
3.
4

At the printer control panel, press the Services Home button.
To add a fax address book entry, touch Fax.
Touch the Enter Fax Number field, then to enter the number, use the touch screen keyboard.

To add the recipient to the address book, touch Create New Contact. The Create New Contact icon
appears as a blue book with a green plus (+) sign.

Touch Create New Contact.
To enter contact information, do one or more of the following:
—  Enter the name to display in the address book.

— To add name and company information for the new entry, to the right of the contact field,
touch the i button. For the First Name, Last Name, or Company fields, enter a name, then touch
OK.

— To enter an email address for the contact, to the right of the green fax icon, touch the field. To
enter the address, use the touch screen keyboard.

— To enter an Internet fax number for the contact, to the right of the blue Internet Fax icon,
touch the field. To enter the number, use the alphanumeric keyboard.
Notes:

e  The first entry into one of the fields becomes the display name for the contact information.
e The fax number that you previously entered appears to the right of the green fax icon.

To mark a contact as a favorite, to the right of the global address book, email, fax, or Internet fax
fields, touch the corresponding star.

To save the contact to the Device Address Book, touch OK.

Editing or Deleting Favorites in the Device Address Book

1.
2.
3.

10.

11.

At the printer control panel, press the Services Home button.
Touch Email or Internet Fax.

Depending on the printer settings, one of two options displays. Touch Device Address Book or
Network Address Book.

Under Names, touch a contact name.
Touch Details.

To change the display name of the contact, touch the i button, edit the information in the fields,
then touch OK.

To enter the email address, to the right of the email icon, touch the field. To enter the address, use
the touch screen keyboard.

To enter a fax number for the contact, to the right of the green fax icon, touch the field. To enter
the number, use the alphanumeric keyboard.

To enter an Internet fax number for the contact, to the right of the blue Internet Fax icon, touch the
field. To enter the number, use the alphanumeric keyboard.

To mark a contact as a favorite, to the right of the global address book, email, fax, or Internet fax
fields, touch the corresponding star.

To save the contact to the Device Address Book, touch OK.
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Cleaning the Printer

This section includes:

GENETAL PrOCAULIONS ..ottt sssse st es et b bbb 148
CleaNiNg the EXTEIION ...t ti et essse s ssesss s s esins 149
ClEANING ThE SCONNET ...ttt sssssssssssssssssss s ssssssssss s sssss s sssssbss s s s s st s s s s besnssssnssnsses 149
CleaniNg the INTEIION ...t ssssssss s s s ssssssssse s ssses s s ssssassssssssessssssssessssasssessasasssssssssssns 151

General Precautions

A

A

148

CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent lighting.
Do not touch or scratch the surface of the drum.

CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as
directed in this documentation.

WARNING: Keep all cleaning materials out of the reach of children.

WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays
contain explosive mixtures and are not suitable for use in electrical applications. Use of pressurized
spray cleaners increases the risk of fire and explosion.

WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain
or service any parts that are behind these covers and guards. Do not attempt any maintenance
procedure that is not described in the documentation supplied with your printer.

WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open.

Do not place anything on top of the printer.

Do not leave the covers and doors open for any length of time, especially in well-lit places. Light
exposure can damage the drum cartridge.

Do not open covers and doors during printing.
Do not tilt the printer while it is in use.

Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print
quality to deteriorate.

Ensure any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Exterior

Clean the exterior of the printer once a month.
e  Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth.
e  After cleaning, wipe with a dry, soft cloth.

e  Forstubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain
off.

‘,i\_ CAUTION: Do not spray detergent directly on the printer. Liquid detergent could enter the printer
through a gap and cause problems. Never use cleaning agents other than water or mild detergent.

Cleaning the Scanner

Clean the scanner about once a month, when anything is spilled on it, or when debris or dust collect on
any of the surfaces. Keep the feed rollers clean to ensure the best possible copies and scans.

Cleaning the Scanner

1. Slightly dampen a soft, lint-free cloth with water.
2. Remove any paper from the duplex automatic document feeder.
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4.  Wipe the surfaces of the document glass and CVT glass until they are clean and dry.

Note: For best results, to remove marks and streaks, use a standard glass cleaner.

6. Close the duplex automatic document feeder.
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Cleaning the Feed Rollers on the Duplex Automatic Document Feeder

1. Open the duplex automatic document feeder top cover.

2. With aclean, lint-free cloth moistened with water, wipe the feed rollers and the separation pad until
they are clean.

Note: If the duplex automatic document feeder feed rollers and separation pad get stained with
toner or debris, they can cause stains on the documents. To remove stains, use a soft lint-free cloth
dampened with a neutral detergent or water.

Cleaning the Interior

To prevent stains inside the printer that can deteriorate print quality, clean the interior of the printer
regularly. Clean the printer interior whenever you replace the drum cartridge.

After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer before closing
the printer covers and doors.

e Remove any remaining pieces of paper or debris. For details, see Clearing Paper Jams on page 167.
e Remove any dust or stains with a dry, clean cloth.

& WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off
the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the
printer has cooled.
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Ordering Supplies

This section includes:

O CONSUMADLES ...ttt ss s s s s s s e e sessss e saes s s s s s s snes 152
e ROULINE MAINTENANCE TTEMS ...ttt bt b st st basenas 152
®  WhEN £0 OFAEr SUPPLIES.....creeereeerreresieseetessesssissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssnsssssssssnsssnnes 153
®  ViIieWIiNG PriNTEr SUPPLY STATUS ...ttt sesssssssssssssssssssssssssssssssssssssssssssssssssssesssssssssssssssssssssssssees 153
® T ONET CAMIIAGES ettt ta s b es e e b e 154
®  RECYCIING SUPPLES ..ottt issssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssnsssnnsssnees 155
Consumables

Consumables are printer supplies that get depleted during the operation of the printer. The consumable
supply for this printer is the genuine Xerox® Black Toner Cartridge.

Notes:

e Each consumable includes installation instructions.

e Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner
remaining amount displayed could be inaccurate.

e To ensure print quality, the toner cartridge has been designed to cease functioning at a

predetermined point.

‘& CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer

reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by
Xerox for specific use with this printer.

Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:
e  Smart Kit Drum Cartridge

e Staple Cartridge

¢ Maintenance Kit
e  Feed Roller Kit

Note: Not all options listed are supported on all printers. Some options apply only to specific printer
models or configurations.

152
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When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you have
replacements on hand. It is important to order these items when the messages first appear to avoid
interruptions to your printing. An error message appears on the control panel when supplies must be
replaced.

Order supplies from your local reseller or go to www.xerox.com/office/WC3655supplies.

.r’i'“. CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement,
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary
outside these areas. Please contact your Xerox representative for details.

Viewing Printer Supply Status

You can check the status and percentage of life remaining for your printer supplies at any time using
CentreWare Internet Services or the control panel.

To view printer supply status using CentreWare Internet Services:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then
press Enter or Return.

Note: For details, see the System Administrator Guide at www.xerox.com/office/WC3655docs.

2. Select the Status tab.
3. Under Status, click Supplies.

To view printer supply status using the control panel:

At the control panel, press Machine Status, then touch the Supplies tab.
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Toner Cartridges

This section includes:
@ GONETOL PrOCOULIONS .ot eeeeeastseesesessessssssssssaseassssssssassssasssasesssassassssassassasssasenssassassssasensenssnsanes 154
®  Replacing A TONEE CAMIAGE.....irrrrrinrsinssessssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnses 155

General Precautions

/A WARNINGS:
e  When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid
contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

o  Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the
child spit out the toner, and rinse out their mouth with water. Consult a physician immediately.

e  Use adamp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. Electric
sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of
toner, contact your local Xerox representative.

e  Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch
fire and cause burn injuries or an explosion.

‘,i\ WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain
or service any parts that are behind these covers and guards. Do not attempt any maintenance
procedure that is not described in the documentation supplied with your printer.

e Do not open covers and doors during printing.

e Do not leave the covers and doors open for any length of time, especially in well-lit places. Light
exposure can damage the drum cartridge.

e Do not place anything on top of the printer.
e Do not tilt the printer while it is in use.

e Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print
quality to deteriorate.

e  Ensure any parts removed during cleaning are replaced before you plug in the printer.
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Replacing a Toner Cartridge

When a toner cartridge approaches the end of its usable life span, the control panel displays a toner low
message. When a toner cartridge is empty, the printer stops and displays a message on the control
panel.

Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining
amount displayed could be inaccurate.

Note: Each toner cartridge includes installation instructions.

Printer Status Message Cause and Solution

Toner Low The toner cartridge is low. Order a new toner cartridge.

Toner Empty. Open the Front Cover. Then replace the | The toner cartridge is empty. Open the front door and
Toner Cartridge. replace the toner cartridge.

Recycling Supplies

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa.
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Managing the Printer

This section includes:

®  AQJUSEING The AU oottt ss s sssse s ses s s s ss s s sas s ssses s ssssnsssnees 156
®  MOVING L@ PrINTEN ..ottt s s sas bbb s bbb ansae 157
Adjusting the Altitude

Use Adjust Altitude to adjust the altitude to match that of the location where the printer is installed. If
the altitude setting is incorrect, it can cause print-quality problems.

To adjust the altitude:

1. At the printer control panel, press the Machine Status button, then touch the Tools tab.
2. Touch Device Settings.

3. Touch General.
4

If needed, log in as administrator. For details, see the System Administrator Guide at
www.xerox.com/office/WC3655docs.

Touch Altitude Adjustment.
To select the measurement units, touch Meters or Feet.

o u

7. Touch the altitude of the location of the printer, then press Save.
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Moving the Printer

/A WARNINGS:
e To prevent dropping or tipping the printer, hold the printer between two people, with each
person using one hand underneath to hold the printer and the other hand on top to stabilize it.

e If the optional 550-Sheet Feeder is installed, uninstall it before you move the printer. If the
optional 550-Sheet Feeder is not fixed to the printer securely, it could fall to the ground and
cause injury.

Follow these instructions when moving the printer:

1. Turn off the printer and disconnect the power cord and other cables from the back of the printer.
For details, see Turning the Printer On and Off on page 36.

‘,i\ WARNING: To prevent electric shock, never touch the power plug with wet hands. When removing
the power cord, ensure that you pull the plug and not the cord. Pulling the cord can damage it, which
can lead to fire or electric shock.

2. Remove any paper or other media from the output tray.
3. If the output tray extension is extended, close it.

4. Remove the paper from the paper tray.
Keep the paper wrapped and away from humidity and dirt.
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5. When lifting the printer, grasp the areas as shown.

Notes:
e  When moving the printer, do not tilt it more than 10 degrees to the front, back, left, or right.
Tilting the printer more than 10 degrees can cause toner spillage.

e  Repack the printer and its options using the original packing material and boxes or a Xerox
Repackaging Kit. For a repacking kit and instructions, go to
www.xerox.com/office/WC3655support.

& CAUTION: Failure to repackage the printer properly for shipment can result in damage not covered
by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty,
Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by
improper moving.

After moving the printer:

1. Reinstall any parts you removed.

2. Reconnect the printer to the cables and power cord.
3. Plugin and turn on the printer.
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Troubleshooting

This chapter includes:

e  General Troubleshooting 160
e  Paper Jams 165
e  Getting Help... 187
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General Troubleshooting

This section includes:

Printer Includes Power Switch and POWEr BULLON ...t seenes 160
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PriNTEr FAIlS 1O POWET ONooeeereeeereseessiessstessessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssssssnssssssssnnses 161
Printer Resets or TUNS Off FIEQUENLLY ... csessesesstssssssssss s ssssesssssessssssssssssssssssssssssssssssnns 161
Document Prints From WIONG TTAY ... cssse e ssssessssssssessssesssssssssssssssssessssssssessssessssssssesssssssseses 161
Automatic 2-Sided Printing PrODIEMS ...t ssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssens 162
PAPET TrAY FQILS £0 ClOSE...euuieereerieeiesriessisseeissssssissssssssssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssssessssssssssssnees 162
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PHINEEEN FAILS 1O PIINT oottt ssessstssssssssisssstsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssssssssssnnes 163
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This section contains procedures to help you locate and resolve problems. Resolve some problems by
simply restarting the printer.

Printer Includes Power Switch and Power Button

This printer has both a power switch and a power button. The power switch on the side of the printer
controls the main power to the printer. The control panel power button controls power to the printer
electronic components. For details, see Turning the Printer On and Off on page 36.

Restarting the Printer

To restart the printer:

1.
2.

On the control panel, press Power.

Touch Power Down.

Note: After 10 seconds, the touch screen goes dark and the Power Saver button flashes until the
printer has completed powering down.

If the printer turns off, to restart the printer, press Power.

If the printer does not turn off after two minutes, turn off the power switch on the side of the
printer.

To restart the printer, turn on the power switch.

160

Note: If restarting the printer does not resolve the problem, see the table in this chapter that best
describes the problem.
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Printer Fails to Power On

Probable Causes

Troubleshooting

Solutions

One of the power switches is not turned on.

Turn on both power switches. For details, see Turning the Printer On
and Off on page 36.

The power cord is not correctly plugged into
the outlet.

Turn off the printer power switch, and plug the power cord securely
into the outlet. For details, see Turning the Printer On and Off on
page 36.

Something is wrong with the outlet
connected to the printer.

e Plug another electrical appliance into the outlet and see if it

operates properly.
Try a different outlet.

The printer is connected to an outlet with a
voltage or frequency that does not match the
printer specifications.

Use a power source with the specifications listed in the Electrical
Specifications on page 198.

& CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet.

Printer Resets or Turns Off Frequently

Probable Causes

The power cord is not plugged into the outlet
correctly.

Solutions

Turn off the printer, confirm that the power cord is plugged in
correctly to the printer and the outlet, then turn on the printer.

A system error occurred.

Turn off the printer, then turn it on again. Print the Error History
from the Information Pages of the Printer Setting Utility. If the error
persists, contact your Xerox representative.

The printer is connected to an uninterruptible
power supply.

Turn off the printer, then connect the power cord to a suitable
outlet.

The printer is connected to a power strip
shared with other high-power devices.

Plug the printer directly into the outlet or into a power strip that is
not shared with other high-power devices.

Document Prints From Wrong Tray

Probable Causes

Solutions

Application and print driver have conflicting
tray selections.

1. Check the tray selected in the print driver.

2. Go to the page setup or printer settings of the application from
which you are printing.

Set the paper source to match the tray selected in the print
driver or set the paper source to Automatically Select.

Note: To have the print driver select the tray, set the tray used as
the paper source to Auto Selection Enabled.
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Automatic 2-Sided Printing Problems

Probable Causes

Unsupported or incorrect paper.

Solutions

Ensure that you are using a supported paper size and weight for
2-sided printing. Envelopes and labels cannot be used for 2-sided
printing. For details, see Supported Standard Types and Weights for
Automatic 2-Sided Printing and Supported Standard Paper Sizes for
Automatic 2-Sided Printing.

Incorrect setting.

In the print driver Properties, select 2-Sided Print on the
Paper/Output tab.

Paper Tray Fails to Close

Probable Causes

Solutions

The paper tray does not close fully.

e The paper tray lift plate is not locked down. Push down on the
paper stack at the back of the tray until it locks down.

o If the tray is extended for legal size paper, the tray protrudes
when it is inserted into the printer.

e Some debris or an object is blocking the tray.

Printing Takes Too Long

Probable Causes

The printer is set to a slower printing mode.
For example, the printer could be set to print
on Heavyweight paper.

Solutions

It takes more time to print on certain types of special paper. Ensure
that the paper type is set properly in the driver and at the printer
control panel. For details, see Print Speed on page 199.

The printer is in Power Saver mode.

It takes time for printing to start when the printer is coming out of
Power Saver mode.

The way the printer was installed on the
network could be an issue.

Determine if a print spooler or a computer sharing the printer is
buffering all print jobs and then spooling them to the printer.
Spooling can slow print speeds. To test the speed of the printer,
print some information pages such as the Office Demo Page. If the
page prints at the rated speed of the printer, you could have a
network or printer installation issue. For additional help, contact the
system administrator.

The job is complex.

Wait. No action needed.

The print-quality mode in the driver is set to
Enhanced.

Change the print-quality mode in the print driver to Standard.
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Printer Fails to Print

Probable Causes

The printer has an error.

Troubleshooting

Solutions

e To clear the error, follow the onscreen prompts.

e Turn off the printer, then turn it on again. If the error persists,
contact your Xerox representative.

The printer is out of paper.

Load paper into the tray.

A toner cartridge is empty.

Replace the empty toner cartridge.

The front door is open.

e Ensure that the toner cartridge and Smart Kit drum cartridge are
installed and fully seated.

e Ensure that the door is closed completely.

e Turn off the printer, then turn it on again. If the error persists,
contact your Xerox representative.

The power cord is not correctly plugged into
the outlet.

Turn off the printer, confirm that the power cord is plugged in
correctly to the printer and the outlet, then turn on the printer. For
details, see Turning the Printer On and Off on page 36. If the error
persists, contact your Xerox representative.

The printer is busy.

e A previous print job could be the problem. On your computer,
you can use the printer properties to delete all print jobs in the
print queue.

e Load the paper in the tray.
e At the control panel, touch Job Status. If the print job does not

appear check the Ethernet connection between the printer and
the computer.

e At the control panel, touch Job Status. If the print job does not
appear, check the USB connection between the printer and the
computer. Turn off the printer, then turn it on again.

The printer cable is disconnected.

e At the control panel, touch Job Status. If the print job does not
appear check the Ethernet connection between the printer and
the computer.

e At the control panel, touch Job Status. If the print job does not
appear, check the USB connection between the printer and the
computer. Turn off the printer, then turn it on again.

Printer Makes Unusual Noises

Probable Causes

Solutions

There is an obstruction or debris inside the
printer.

Turn off the printer and remove the obstruction or debris. If you
cannot remove it, contact your Xerox representative.

The Smart Kit Drum Cartridge is not fully
seated.

Remove and reseat the Smart Kit Drum Cartridge.
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Condensation Has Formed Inside the Printer

Moisture can condense inside a printer where the humidity is above 85 % or when a cold printer is
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that
is heated quickly.

Probable Causes Solutions
The printer has been sitting in a cold room. | e  Allow the printer to acclimate for several hours before operation.
e Allow the printer to operate for several hours at room
temperature.

The relative humidity of the room is too high. [e Reduce the humidity in the room.

¢ Move the printer to a location where the temperature and
relative humidity are within the operating specifications.
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Paper Jams

This section includes:

LOCALING PAPEE JAMS ...ttt e sssse st ssssessssssssesssssssssssssssssssssssssssssssessssssssessssssssssssssssssssssesssnees 165
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ClEAriNG PAPEE JAMS ....oveevreersresetnssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssssnssssssssssssssssssssssnssssssssnssses 167
TroubleShOOtING PAPEI JAMS..... e sesesssssesssssssssssesssssssssssssssssssssssssssssssesssssssssssssssssssssssssssssssssssssanes 177
PrHNT-QUALILY PrODIEMIS ..ottt sttt bass s sssssss et s bbb ss s sansbanes 179
COPY AN SCAN PrODIEMS ...ttt sessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnasssssssnssses 184
FOX PrODLEIMIS ... oottt sasssssss e ssss st s ssse s s s s b s s bbb s s b s s et ssnsssnnes 185

Locating Paper Jams

A

A

WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off
the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the
printer has cooled. If the error persists, contact your Xerox representative.

CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can permanently
damage the printer.

The following illustration shows where paper jams can occur along the paper path:

1. Optional trays 4. Bypass Tray
2. Duplex Automatic Document Feeder 5. Tray 1
3. Fuser

Xerox® WorkCentre® 3655 Multifunction Printer 165
User Guide



Troubleshooting

Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper
types can cause jams. If supported paper is jamming frequently in one aregq, clean that area of the paper
path.

The following can cause paper jams:

e Selecting the incorrect paper type in the print driver.
e Using damaged paper.

e  Using unsupported paper.

e Loading paper incorrectly.

e  Overfilling the tray.

e  Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

e Use only supported paper. For details, see Supported Paper on page 48.
e  Follow proper paper handling and loading techniques.

e Always use clean, undamaged paper.

e Avoid paper that is curled, torn, moist, creased, or folded.

e To separate the sheets before loading into the tray, fan the paper.

e  Observe the paper tray fill line; never overfill the tray.

e  Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted
can cause poor print quality, misfeeds, skewed prints, and printer damage.

o After loading the trays, select the correct paper type and size on the control panel.

e  When printing, select the correct type and size in the print driver.

e Store paperin adry location.

¢ Do not open sealed packages of paper until you are ready to load them into the printer.

e Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture
loss or gain.

Avoid the following:

e Polyester coated paper that is specially designed for inkjet printers.

e Paper that is folded, wrinkled, or excessively curled.

e Loading more than one type, size, or weight of paper in a tray at the same time.
e  Overfilling the trays.

e Allowing the output tray to overfill.

For a detailed list of supported paper, go to www.xerox.com/paper.
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Clearing Paper Jams

This section includes:

e  Clearing Paper Jams from the Duplex Automatic Document Feeder ... cnnrensinnsrenssernssennenns 167
o  Clearing Paper Jams from the BYPASS TIAY .....cceverrermrrermrinmeenssesesnssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssseses 168
o Clearing Paper Jams from the TraY T ATEQ ... sssssssssssssssssssssesssssssssssessssssssssesssssessssssssns 170
o  Clearing Paper Jams from the TrAY 2—4 AFEU....iriensrenrinssinssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 172
o  Clearing Paper JAmS from the FUSET ATQx .......ionrinnrinsensissssnssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 174

Clearing Paper Jams from the Duplex Automatic Document Feeder

1. Remove the remaining paper from the duplex automatic document feeder.
2. Open the duplex automatic document feeder top cover.

3. If the paper is jammed in the exit of the duplex automatic document feeder, pull it out as
illustrated.

4,  Close the document cover.

5. Reload the document in the duplex automatic document feeder, then adjust the guides against the
edges of the paper.
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Clearing Paper Jams from the Bypass Tray

To resolve the error displayed on the control panel you must clear all paper from the paper path.
1.  Remove any paper from the bypass tray.

2. Grasp both sides of the bypass tray, then pull it straight out of the printer.

3. Pull out the tray until it stops.
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To remove the tray, lift the front of it slightly, then pull it out of the printer.

Note: If the tray is extended for legal size paper, the tray protrudes when it is inserted into the
printer.

Insert the bypass tray back into the printer. Push the tray in all the way.
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8. If the control panel prompts you, on the screen, verify the paper size and type.
e Touch Size, then, for a standard paper size, touch an option.

Touch Type, then, for the paper type, touch an option.

Touch Color, then select the paper color.

9. Touch Confirm.

Clearing Paper Jams from the Tray 1 Area

To resolve the error displayed on the control panel you must clear all paper from the paper path.
1. Remove any paper from the bypass tray.

2. Grasp both sides of the bypass tray, then pull it straight out of the printer.

3. Pull out the tray until it stops.
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To remove the tray, lift the front of it slightly, then pull it out of the printer.

Note: If the tray is extended for legal size paper, the tray protrudes when it is inserted into the
printer.

Insert the bypass tray back into the printer. Push the tray in all the way.
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8. If the control panel prompts you, on the screen, verify the paper size and type.
e  Touch Size, then, for a standard paper size, touch an option.

Touch Type, then, for the paper type, touch an option.

Touch Color, then select the paper color.

9. Touch Confirm.

Clearing Paper Jams from the Tray 2-4 Area

To resolve the error displayed on the control panel you must clear all paper from the paper path.
Note: The procedure for clearing jams is identical for trays 2-4.

1. Pull out tray 2 until it stops.

2. Toremove the tray, lift the front of it slightly, then pull it out of the printer.

3. Remove any paper jammed at the front of the printer.
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4. At the back of the printer, open the tray 2 door, then remove any paper jammed at the back of the
printer.

5.

Note: If the tray is extended for legal size paper, the tray protrudes when it is inserted into the
printer.

6. If the control panel prompts you, on the screen, verify the paper size and type.
e  Touch Size, then, for a standard paper size, touch an option.

Touch Type, then, for the paper type, touch an option.

Touch Color, then select the paper color.

7. Touch Confirm.
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Clearing Paper Jams from the Fuser Area

To resolve the error displayed on the control panel you must clear all paper from the paper path.

.r’i'“. WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off

the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the
printer has cooled. If the error persists, contact your Xerox representative.

.r’i'“. CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can permanently
damage the printer.

1. Toopen the rear door, pull the release and lower the cover.

2. If paperis jammed in the fuser, raise both green levers to open the fuser.

.

3. Toopen the paper guide, raise the green handle.
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Remove any jammed paper from the back of the printer.

4,

Close the paper guide on the fuser.

5.

\

A\

Lower the levers to their original position.

6.

175

Xerox® WorkCentre® 3655 Multifunction Printer

User Guide



Troubleshooting

7.  Remove any jammed paper from the back of the printer.

8. Close the rear door.
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Troubleshooting Paper Jams

This section includes:

Troubleshooting

o Multiple SHEets PULlEd TOGELNET ...ttt ssss s sssssssssss s sssss b ssssssssss s ssssnses 177
O PAPET MISTEEAS ...ttt sttt sssss s sssssssss s sss s s s b s b s Ssss s s s sns b s s sa s s s s b st s ssess 177
o Label aNd ENVEIOPE MISTEEAS ...ttt sssssass s sssss s sss s sssasssassssassssssssasssssnees 178
o Paper JAmM MeESSAGE STAYS ONu...irererrereiesisssiesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 178
o Jams During AutomatiC 2-Sided PrNTING ........cereimrinnsinrensinssinsssssssnssssssssssssssssssssssssssssssssssssssssssssssssssssseses 178

Multiple Sheets Pulled Together

Probable Causes

The paper tray is too full.

Solutions

Remove some of the paper. Do not load paper past fill line.

The edges of the paper are not even.

Remove the paper, align the edges, and then reload it.

The paper is moist from humidity.

Remove the paper from the tray, and replace it with new dry paper.

Too much static electricity is present.

Try a new ream of paper.

Using unsupported paper.

Use only Xerox®-approved paper. For details, see Supported Paper
on page 48.

Humidity is too high for coated paper.

Feed paper one sheet at a time.

Paper Misfeeds

Probable Causes

The paper is not correctly positioned in the
tray.

Solutions

e Remove the misfed paper and reposition it properly in the tray.
e Adjust the paper guides in the tray to match the size of the
paper.

The paper tray is too full.

Remove some of the paper. Do not load paper past the fill line.

The paper guides are not correctly adjusted
to the paper size.

Adjust the paper guides in the tray to match the size of the paper.

The tray contains warped or wrinkled paper.

Remove the paper, smooth it out, and reload it. If it still misfeeds,
do not use that paper.

The paper is moist from humidity.

Remove the moist paper and replace it with new, dry paper.

Using paper of the wrong size, thickness, or
type.

Use only Xerox approved paper. For details, see Supported Paper on
page 48.

Xerox® WorkCentre® 3655 Multifunction Printer 177
User Guide



Troubleshooting

Label and Envelope Misfeeds

Probable Causes

The label sheet is facing the wrong way in the
tray.

Solutions

¢ Load label sheets according to the instructions from the
manufacturer.

e Load labels in the tray, face up.

For details, see Labels on page 65.

Labels are missing, curled, or pulled away
from the backing sheet.

Do not use any sheet where labels are missing, curled, or pulled
away from the backing sheet.

Envelopes are loaded incorrectly.

Load envelopes in the bypass tray only.
For details, see Loading Envelopes in the Bypass Tray on page 63.

Envelopes are wrinkling.

e The heat and pressure of the laser printing process can cause
wrinkling.
e Use supported envelopes. For details, see Guidelines for Printing

Envelopes on page 62.

Paper Jam Message Stays On

Probable Causes

Solutions

Some paper remains jammed in the printer.

Recheck the media path and ensure that you have removed all of
the jammed paper.

One of the printer doors is open.

Check the doors on the printer and close any door that is open.

The rear door interlock switch is not reset.

To reset the interlock switch and clear the paper jam message, open
and close the back door.

Note: Check for, and remove, torn pieces of paper in the paper path.

Jams During Automatic 2-Sided P

Probable Causes

Using paper of the wrong size, thickness, or
type.

rinting

Solutions

Use paper of the correct size, thickness, or type. For details, see
Supported Paper Sizes for Automatic 2-Sided Printing.

Paper is loaded in the wrong tray.

The paper must be loaded in the correct tray. For details, see
Supported Paper on page 48.

Tray is loaded with mixed paper.

Load the tray with only one type and size of paper.

178 Xerox® WorkCentre® 3655 Multifun

User Guide

ction Printer



Troubleshooting

Print-Quality Problems

This section includes:
®  CoNtrolling Print QUALILY ...ccueeveereererresesiessesssiessisssaessesssssss st sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssnsssnnses 180
o Solving Print-QUAlItY PrODIEMIS ...ttt sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnnses 181

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems,
use the information in this section to troubleshoot the problem. For more information, go to
www.xerox.com/office/WC3655support.

.r’i‘m CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction
Guarantee is available in the United States and Canada. Coverage could vary outside these areas.
Please contact your local representative for details.

Note: To ensure consistent print quality, the toner cartridges and imaging units for many models of
equipment are designed to cease functioning at a predetermined point.
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Troubleshooting

Controlling Print Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print
quality, use paper designed for your printer and set the paper type correctly. Follow the guidelines in this
section to maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal
print quality is: 15-28°C (59-82°F) and 20-70 % relative humidity.

Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section
for the best print quality and to avoid jams:

e Use only Xerox approved paper. For details, see Supported Paper on page 48.
e  Use only dry, undamaged paper.

/1 CAUTIONS: Some paper and other media types can cause poor output quality, increased paper jams,
or damage your printer. Do not use the following:

¢ Rough or porous paper
e Inkjet paper
o Non-laser glossy or coated paper
e Paper that has been photocopied
e Paper that has been folded or wrinkled
e Paper with cutouts or perforations
e Stapled paper
e Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes
e Plastic media
e Transparencies
e  Ensure the paper type selected in your print driver matches the paper type on which you are
printing.
e If you have the same size paper loaded in more than one tray, ensure that the proper tray is
selected in the print driver.

e  Store your paper and other media properly for optimum print quality. For details, see Paper Storage
Guidelines on page 49.
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Solving Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table and see the
corresponding solution to correct the problem. You can also print a Demo Page to more precisely
determine the print-quality problem.

If the print quality does not improve after carrying out the appropriate action, contact your Xerox
representative.

Note: To maintain print quality, the toner cartridge is designed to provide a warning message when
the toner level is low. When the toner cartridge reaches this level, a warning message appears. Once
the toner cartridge is empty, another message prompts you to replace the toner cartridge. The
printer stops printing until you install a new toner cartridge.

Symptom Solutions

The output is too light. e To check the toner level, check the control panel, use the print driver, or
CentreWare Internet Services. If the toner cartridge is near empty,
replace it.

o Verify that the toner cartridge is approved for use in this printer, and
replace it as needed. For best results, use a genuine Xerox toner cartridge.

e Ensure that the print quality mode is not set to Toner Saver. Toner Saver
us useful for draft quality output.

e Replace the paper with a recommended size and type, and confirm that
your printer and print driver settings are correct.

e Verify that the paper is dry and that supported paper is used. If not,
change the paper.

e Change the Paper Type settings in the print driver.

In the Printing Preferences of the print driver, on the Paper/Output tab,
change the Paper Type setting.

e If printer is located in a high altitude environment, adjust the altitude
setting of the printer. For details, see Adjusting the Altitude on page 156.

Toner smears or print comes off. e Change the Paper Type settings in the print driver. For example, change
The output has stains on the back Plain to Lightweight Cardstock.
side. In the Printing Preferences of the print driver, on the Paper/Output tab,

change the Paper Type setting.
o Verify that the paper is the correct size, type, and weight. If not, change

the paper settings.
ABC o Verify that the printer is plugged into an outlet that is providing the
correct voltage and power. Review the electrical specification of the

D E printer with an electrician if necessary. For details, see Electrical
Specifications on page 198.
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Symptom

Random spots on the output, or the
image is blurry.

ABC
DEF

Solutions

Ensure that the toner cartridge is installed correctly.

If you used a non-genuine brand toner cartridge, install a genuine Xerox
toner cartridge.

Use the Rough paper type setting, or try a paper with a smoother surface.

Ensure that the humidity in the room is within specifications. For details,
see Relative Humidity.

The output is blank.

Turn off the printer, then turn it on again.
If the error persists, contact your Xerox representative.

Streaks appear in the output.

B

3

Replace the Smart Kit Drum Cartridge.
Contact your Xerox representative.

The output has a mottled
appearance.

Verify that the paper is the correct size, type, and weight. If not, change
the paper settings.

Ensure that the humidity in the room is within specifications. For details,
see Relative Humidity.
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Symptom Solutions

Ghosting appears in the printed o Verify that the paper is the correct size, type, and weight. If not, change
output. the paper settings.

e Change the Paper Type settings in the print driver.

In the Printing Preferences of the print driver, on the Paper/Output tab,
change the Paper Type setting.

e Replace the Smart Kit Drum Cartridge.

A®

Auger marks appear on the printed | e To check the toner level, check the control panel, use the print driver, or
output. CentreWare Internet Services. If the toner cartridge is near empty,
replace it.

o Verify that the toner cartridge is approved for use in this printer, and
% \C replace it as needed. For best results, use a genuine Xerox toner cartridge.
\\

"DEE.

NN
N
The output print is wrinkled or o Verify that the paper is the correct size, type, and weight for the printer

stained. and that it is loaded properly. If not, change the paper.
e Try a new ream of paper.

e Change the Paper Type settings in the print driver.

In the Printing Preferences of the print driver, on the Paper/Output tab,
change the Paper Type setting.

Envelopes are wrinkled or creased Check if the crease is within 30 mm (1.2 in.) of the four edges of the
when printed. envelope.

o If yes,itis printing as expected. Your printer is not faulty.

o If not, take the following actions:

Ensure that envelopes are loaded properly in the bypass tray. For details,
see Loading Envelopes in the Bypass Tray on page 63.

Follow the guidelines for printing on envelopes. For details, see Guidelines
for Printing Envelopes on page 62.

If the problem persists, use a different size envelope.
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Symptom Solutions

ABC
DEF

The top margin is incorrect. e Ensure that the paper is loaded properly.
e Ensure that the margins are set correctly in the application you are using.

bumpy.

ABC
DEF

The printed surface of the paper is 1. Print a solid image over the entire surface of one sheet of paper.
2. Load the printed sheet into the tray with the printed side face down.
3. Print five blank pages to remove debris from the fuser rollers.

Copy and Scan Problems

If the copy or scan quality is poor, refer to the following table.

Symptoms Solutions

Lines or streaks present in copies only made
from the document feeder.

There is debris on the document glass. When scanning, the paper
from the document feeder passes over the debris creating lines or
streaks. Clean all glass surfaces with a lint-free cloth.

Spots present in copies taken from the
document glass.

There is debris on the document glass. When scanning, the debris
creates a spot on the image. Clean all glass surfaces with a lint-free
cloth.

The reverse side of the original is showing on
the copy or scan.

Turn on Background Suppression.

Image is too light or too dark.

e Copy: To lighten, darken, or adjust contrast, use the Image
Quality settings.

e Scan: To lighten, darken, or adjust contrast, use the Advanced
Settings Tab.

If the problem persists, for online support information, go to www.xerox.com/office/WC3655support.
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Fax Problems

This section includes:
e  Problems Sending Faxes

e  Problems Receiving Faxes

Troubleshooting

Note: If you cannot send and receive faxes, make sure that you are connected to an approved
analog telephone line. The fax cannot send or receive when connected to a digital phone line.

If you cannot send or receive faxes correctly, refer to the following tables.

Problems Sending Faxes

Symptoms

The document is not scanned
using the document feeder.

Causes

The document is too thick, too thin, or
too small.

Solutions

Use the document glass to send the
fax.

The document is scanned at an
angle.

The document feeder guides are not
adjusted to the width of the document.

Adjust the document feeder guides to
fit the width of the document.

The fax received by the recipient
is blurry.

The document is incorrectly positioned.

Position the document correctly.

The document glass is dirty.

Clean the document glass.

The text in the document is too light.

Adjust the resolution. Adjust the
contrast.

There is a problem with the telephone
connection.

Verify that the telephone line is
working, then send the fax again.

There is a problem with the fax
machine of the caller.

Make a copy to verify that your printer
is operating correctly. If the copy was
printed correctly, have the recipient
verify the condition of their fax
machine.

The fax received by the recipient
is blank.

The document was loaded incorrectly.

e Document feeder: Place the original
document face up.

e Document glass: Place the original
document face down.

Fax was not transmitted.

The fax number is wrong.

Verify the fax number.

The telephone line is incorrectly
connected.

Verify the telephone line connection. If
it is disconnected, connect it.

There is a problem with the fax
machine of the recipient.

Contact the recipient.

The fax is not installed or is not
enabled.

Verify that the fax is installed and
enabled.

Server Fax is enabled.

Make sure that Server Fax is disabled.

If the problem persists, for online support information, go to www.xerox.com/office/WC3655support.
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Problems Receiving Faxes

Symptoms

The received fax is blank.

Causes

There is a problem with the telephone
connection or with the fax machine of
the caller.

Solutions

Verify that the printer can make clean
copies. If it can, have the caller send
the fax again.

The sender loaded the pages
incorrectly.

Contact the sender.

The printer answers the call, but
does not accept incoming data.

Not enough memory.

If the job contains several graphics, the
printer could not have enough memory.
The printer does not answer when
memory is low. Delete stored
documents and jobs then wait for the
existing job to complete. This increases
available memory.

The received fax size is reduced.

The paper supply in the printer does
not match the document size sent.

Confirm the original size of the
documents. Documents could be
reduced based on the available paper
supply in the printer.

Faxes cannot be received
automatically.

The printer is set to receive faxes
manually.

Set the printer to automatic reception.

The memory is full.

Load paper if it is empty, and then
print the faxes stored in the memory.

The telephone line is incorrectly
connected.

Verify the telephone line connection. If
it is disconnected, connect it.

There is a problem with the fax
machine of the sender.

Make a copy to verify that your printer
is operating correctly. If the copy prints
correctly, have the recipient verify their
fax machine is operating correctly.

If the problem persists, for online support information, go to www.xerox.com/office/WC3655support.
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Troubleshooting

Getting Help

This section includes:

®  CONIOL PANEI MESSUQGES .....eooeeeerreeeresssesssessssessssssssssssssssssssssssssssassssssasssssssssssssssssssssssssssssssssessssssasssssssssssssssssssssssseses 187
e  Using the Integrated TroubleShOOtiNg TOOLS. ...t ssse s sssseeasesssesessesns 188
®  ONlINE SUPPOIT ASSISTANT ...vvenrvereesierrsiessisssissssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnnses 188
®  REIMIOLE SEIVICES.....eorieeires ettt ssss st s s sss s s s s s s bbb RS bbbt n s e 188
®  INTOMMALION PAGES ...coooeeeeeee et sessse s sssssssssssssssssss s s sss s sssess s s s s s s s s s sssssesssssessssnses 189
O MOTE INTOMMIOTION ottt es e sba s 189

Your printer comes with utilities and resources to help you troubleshoot printing problems.

Control Panel Messages

The printer control panel provides information and troubleshooting help. When a fault or warning
condition occurs, the control panel displays a message informing you of the problem. For many status
and warning messages, the control panel Information provides additional information.

Control Panel Help

When a fault occurs that stops the printing operation, such as a paper jam, a message appears on the
screen. A graphical illustration appears to indicate the location of the fault with a brief explanation of
the action to take to clear the fault. The illustration changes to indicate multiple locations and actions to
take.

Viewing Warning Messages on the Control Panel

When a warning condition occurs, a message appears on the control panel to inform you of the problem.
Warning messages inform you about printer conditions, such as low supplies or open doors, that require
your attention. If more than one warning condition occurs, only one is displayed on the control panel.

Viewing Current Faults on the Control Panel
When a fault condition occurs, a message appears on the control panel to inform you of the problem.

Fault messages warn you about printer conditions that prevent the printer from printing or degrade
printing performance. If more than one fault occurs, only one is displayed on the control panel.
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Viewing Job Status on the Control Panel

To view current or saved jobs on the control panel:

1. At the control panel, press the Job Status button.

To view a list of active jobs, touch Active Jobs.

To view a list of completed jobs, touch Completed Jobs.
To view a list of secure prints, touch Secure Print Jobs.

&~ whN

To view a list of secure faxes received, touchSecure Fax Receive.

Using the Integrated Troubleshooting Tools

Your printer has a printable set of reports. Two of them, the Demo Page and the Error History report, can
help with troubleshooting certain problems. The Demo Page prints an image to show the current ability
of the printer to print. The Error History report prints information on the most recent printer errors.

Printing Reports

1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages.

3. Use the arrows to navigate, then select a report.

4. Touch Print.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to
solve your printer problems. You can find solutions for print-quality problems, paper jams, software
installation issues, and more.

To access the Online Support Assistant, go to www.xerox.com/office/WC3655support.

Remote Services

The Remote Services troubleshooting feature sends diagnostic information from your printer to Xerox
and provides you with solutions to resolve detected issues. You can access interactive troubleshooting
through CentreWare Internet Services.

To access interactive troubleshooting from CentreWare Internet Services:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer
on page 28.

2. Click the Support tab.
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3. Click General.

Troubleshooting

4. To send printer diagnostics information to Xerox for analysis of detected issues and to match with
current solutions, click Start an Online Troubleshooting Session at www.xerox.com.

5. Follow the onscreen instructions.

Information Pages

Your printer has a printable set of information pages. These include configuration and font information,

demonstration pages, and more.

More Information

You can obtain more information about your printer from these sources:

Resource Location

Installation Guide

Packaged with the printer.

Other documentation for your printer

www.xerox.com/office/WC3655docs

Recommended Media List

United States: www.xerox.com/paper
European Union: www.xerox.com/europaper

Technical support information for your printer;
including online technical support, Online Support
Assistant, and driver downloads.

www.xerox.com/office/WC3655support

Information Pages

Print from the control panel, or from CentreWare
Internet Services, click Status>Information Pages.

CentreWare Internet Services documentation

In CentreWare Internet Services, click Help.

Order supplies for your printer

www.xerox.com/office/WC3655supplies

A resource for tools and information, including
interactive tutorials, printing templates, helpful tips,
and customized features to meet your individual
needs.

www.xerox.com/office/businessresourcecenter

Local sales and support center

www.xerox.com/office/worldcontacts

Printer registration

www.xerox.com/office/register

® N: .
Xerox~ Direct online store

www.direct.xerox.com/
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Specifications

This appendix includes:

Printer Configurations and Options
Physical Specifications

Environmental Specifications

Electrical Specifications

Performance Specifications
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Specifications

Printer Configurations and Options

Available Configurations

The Xerox® WorkCentre® 3655 Multifunction Printer is available in two configurations:

e S configuration: This configuration is a network printer with copy, automatic 2-sided printing, scan
functions, and USB or network connectivity.

¢ X Configuration: This configuration is a network printer with copy, automatic 2-sided printing, scan
functions, fax functions, and USB or network connectivity.

Standard Features

The printer provides the following features:

Print speed

Standard mode up to 47 ppm for Letter and 45 ppm for A4

2-Sided print speed

Standard mode up to 29 ppm for Letter and 28 ppm for A4

Functions

Copy, scan, print, and fax

Note: Not all options listed are supported on all printers. Some options apply only
to specific printer models or configurations.

Standard memory

e 2GBRAM
e Internal 250 GB or greater hard drive

Print resolution

e Standard print-quality mode: 600 x 600 dpi
e High Resolution print-quality mode: 1200 x 1200 dpi

2-Sided Printing

Up to 163 g/m? from any tray

Maximum print size

Legal (216 x 356 mm, 85 x 14in.)

Paper capacity

e Bypass Tray: 150 sheets
e Tray 1: 550 sheets
e 550-Sheet Feeder with up to 3 more trays: 550 sheets each

Copy speed

e 1-sided copy: Up to 47 copies per minute for Letter and 45 copies per minute
for A4

e 2-sided copy: Up to 29 copies per minute for Letter and 28 copies per minute
for A4

Copy resolution

600 x 600 dpi

Maximum copy size

Legal (216 x 356 mm, 8.5 x 14in.)

Document feeder

Duplex Automatic Document Feeder

Document feeder capacity

60 sheets

Scan resolution

e Optical: 600 x 600 dpi
e TWAIN: Up to 9600 dpi interpolated
e WIA: Up to 600 dpi
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Specifications

Maximum scan size e Document Glass: 215.9 x 355.6 mm (8.5 x 14 in.)
e Duplex Automatic Document Feeder: 215.9 x 355.6 mm (8.5 x 14in.)
Supported scanning e Scan to SMB

e Scanto FTP

e Scan to Email

e Scan to USB Memory
e Scan to Computer

e WSD Scan
File formats o JPEG
o TIFF
e PDF
Control panel e 7.0-inch LCD touch screen and keypad navigation

e Support for external USB Keyboard

Connectivity e Universal Serial Bus (USB 2.0)

e USB Flash drive

e FEthernet 10/100/1000Base-T

o IEEE802.11 Compliant Wireless Network Adapter (optional)
e Support for external USB Card Reader

Remote access CentreWare Internet Services

Options and Upgrades

o  Wireless network adapter
e  550-Sheet Feeder with up to 3 additional trays
e  Printer Stand
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Specifications

Physical Specifications

Weights and Dimensions

Base Configuration Base Configuration with Optional

550-Sheet Feeder

Width 56.0 cm (22.0in.) 56.0 cm (22.0in.)
Depth 541 cm (21.3in.) 541 cm (21.3in.)
Height 57.5cm (22.7 in.) 66.0 cm (26.0in.)
Weight 25.4kg (56.0Ib.) 31.2kg (68.8 Ib.)
S configuration

Weight 26.3 kg (58.0 Ib.) 32.1kg (70.8 Ib.)
X configuration

Physical Specifications for Standard Configuration
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Physical Specifications for Standard Configuration with Optional 550-Sheet
Feeder

66.0 cm
26in

56.0cm -1¢
220in > £ 21.3in
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Clearance Requirements with Optional 550-Sheet Feeder
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Environmental Specifications

Temperature

e  Operating temperature: 5-32°C (41-90°F)
e  Optimum temperature: 15-28°C (59-82°F)

Relative Humidity

e  Minimum-Maximum Humidity Range: 15-85 % relative humidity at 28°C (82°F)
e  Optimal Humidity Range: 20-70 % relative humidity at 28°C (82°F)

Note: Under extreme environmental conditions, such as 10°C and 85 % relative humidity, defects
can occur due to condensation.

Elevation

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.).
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Electrical Specifications

Power Supply Voltage and Frequency

Power Supply Voltage Power Supply Frequency
100-127 VAC +/-10 %, (90-140 VAC) 50 Hz +/- 3 Hz

60 Hz +/- 3 Hz
220-240 VAC +/-10 %, (198-264 VAC) 50 Hz +/- 3 Hz

60 Hz +/- 3 Hz

Power Consumption

Status S Configuration X Configuration
Power Saver Mode (Sleep): 2.7 W 1.2W 31w
Ready, with fuser on: 81W 82w
Continuous printing: 524w 526W

This printer does not consume electric power when the power switch is turned off even if the printer is
connected to an AC outlet.

ENERGY STAR Qualified Product

The Xerox® WorkCentre® 3655 Multifunction Printer is ENERGY STAR® qualified under
the ENERGY STAR Program Requirements for Imaging Equipment.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United
States, European Union, and Japanese governments and the office equipment industry
to promote energy-efficient copiers, printers, fax, multifunction printers, personal

computers, and monitors. Reducing product energy consumption helps combat smog,
acid rain, and long-term changes to the climate by decreasing the emissions that result
from generating electricity.

Xerox® ENERGY STAR equipment is preset at the factory to switch to Power Saver modes after 2 minutes
from the last copy or print.
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Performance Specifications

Printer warm up time
e  Power on: As fast as 3 minutes and 44 seconds.
e  Recovery from sleep mode: As fast as 5 seconds.

Note: Warm up time assumes an ambient temperature of 20°C (68°F) at 60 % relative humidity.

Print Speed

Maximum print speeds for 1-sided continuous printing are 47 ppm for Letter (8.5 x 11") and 45 ppm for
A4 (210 x 297 mm). The slowest print speed is 7 ppm for enhanced 2-sided printing.

Several factors affect print speed:

e  2-sided printing: The maximum print speeds for 2-sided continuous printing are 29 ppm for Letter
(8.5x11in.) and 28 ppm for A4 (210 x 297 mm).

e  Print mode: Standard is the fastest print mode. Enhanced is half speed, or slower.

e Papersize. Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed. Larger
sizes reduce print speeds.

e  Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels.

Xerox® WorkCentre® 3655 Multifunction Printer 199
User Guide






Regulatory Information

This appendix includes:

Basic Regulations

Copy Regulations

Fax Regulations

Material Safety Data Sheets
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Regulatory Information

Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are
designed to mitigate interference caused or received by this printer in a typical office environment.

United States FCC Requlations

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance
with these instructions, it may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the user will be
required to correct the interference at his/her own expense.

If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.
e Increase the separation between the equipment and receiver.

e  Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

e  Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to
operate this equipment.

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.
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European Union

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with
c € the following applicable Directives of the European Union as of the dates indicated:

e December 12, 2006: Low Voltage Directive 2006/95/EC
e  December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC
e March 9, 1999: Radio & Telecommunications Terminal Equipment Directive 1999/5/EC

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for
the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox.

European Union Lot 4 Imaging Equipment Agreement Environmental
Information

Environmental Information Providing Environmental Solutions and Reducing Cost

The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. This requires manufacturers to improve environmental performance of in scope products
and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.
e Standard monochrome format products with a maximum speed less than 66 A4 images per minute
e Standard color format products with a maximum speed less than 51 A4 images per minute

Introduction

The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. This requires manufacturers to improve environmental performance of in scope products
and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.
e Standard monochrome format products with a maximum speed less than 66 A4 images per minute
e Standard color format products with a maximum speed less than 51 A4 images per minute
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Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of
install. Continuing to use the duplex function will reduce the environmental impact of your work.
However, should you require simplex/1-sided printing, you may change the print settings in the print
driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper
(60 g/m?), which contains less raw material and thus save resources per print, may be used in certain
applications. We encourage you to check if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy
efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and
models qualified to ENERGY STAR can be found at the following website:
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ

Power Consumption and Activation Time

The amount of electricity a product consumes depends on the way the device is used. This product is
designed and configured to enable you to reduce your electricity costs. After the last print, the device
switches to Ready mode. In this mode, the device can print again immediately. If the product is not used
for a period of time, the device switches to a Power Saver mode. In these modes, to enable reduced
product power consumption, only essential functions remain active.

The product takes slightly longer to produce the first print after it exits Power Saver mode than it takes in
Ready mode. This delay is the result of the system waking up from Power Saver mode and is typical of
most imaging products on the market.

You can set a longer activation time or completely deactivate the Power Saver mode. This device can
take longer to switch to a lower energy level.

To learn more about Xerox participation in sustainability initiatives, go to:
www.xerox.com/about-xerox/environment/enus.html.
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Regulatory Information

Environmental Choice Certified to Office Machines CCD-035

This product is certified to Environmental Choice standard for office machines, meeting
all requirements for reduced environmental impact. As part of achieving certification,
oo, Xerox Corporation has proven this product meets the Environmental Choice criteria for

ég*" % energy efficiency. Certified copier, printer, multifunctional device, and fax products

Y B must also meet criteria such as reduced chemical emissions and demonstrate

A%%N.wof compatibility with recycled supplies. Environmental Choice was established in 1988 to
help consumers find products and services with reduced environmental impacts.
Environmental Choice is a voluntary, multi-attribute, and lifecycle-based environmental
certification. This certification indicates that a product has undergone rigorous
scientific testing, exhaustive auditing, or both, to prove its compliance with stringent,
third-party, environmental performance standards.

Germany

Germany - Blue Angel

RAL, the German Institute for Quality Assurance and Labeling, has awarded this device
the Blue Angel Environmental Label. This label distinguishes it as a device that satisfies
Blue Angel criteria for environmental acceptability in terms of device design,
manufacture, and operation. For more information, go to: www.blauer-engel.de.

Blendschutz
Das Gerdt ist nicht fur die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz

vorgesehen. Um storende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht
im unmittelbaren Gesichtsfeld platziert werden.

Larmemission

Maschinenldrminformations-Verordnung 3. GPSGV: Der hochste Schalldruckpegel betrégt 70 dB(A) oder
weniger gemdf EN ISO 7779.

Importeur

Xerox GmbH

HellersbergstraBe 2-4

41460 Neuss

Deutschland
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Turkey RoHS Regulation
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yonetmeligine uygundur.”

Regulatory Information for 2.4 GHz Wireless Network Adapter

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive
99/5/EC.

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the
user's authority to operate this equipment.
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Copy Regulations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

1. Obligations or Securities of the United States Government, such as:
—  Certificates of Indebtedness.
— National Bank Currency.
—  Coupons from Bonds.
—  Federal Reserve Bank Notes.
—  Silver Certificates.
—  Gold Certificates.
—  United States Bonds.
—  Treasury Notes.
—  Federal Reserve Notes.
—  Fractional Notes.
—  Certificates of Deposit.
—  Paper Money.
— Bonds and Obligations of certain agencies of the government, such as FHA and so on.

—  Bonds. United States Savings Bonds may be photographed only for publicity purposes in
connection with the campaign for the sale of such bonds.

—  Internal Revenue Stamps. If it is necessary to reproduce a legal document on which thereis a
canceled revenue stamp, this may be done provided the reproduction of the document is
performed for lawful purposes.

—  Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be
photographed, provided the reproduction is in black and white and is less than 75 % or more
than 150 % of the linear dimensions of the original.

—  Postal Money Orders.
—  Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

—  Stamps and other representatives of value, of whatever denomination, which have been or
may be issued under any Act of Congress.
—  Adjusted Compensation Certificates for Veterans of the World Wars.
2. Obligations or Securities of any Foreign Government, Bank, or Corporation.
3. Copyrighted materials, unless permission of the copyright owner has been obtained or the
reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law.

Further information of these provisions may be obtained from the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.
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4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be
photographed.

Passports. Foreign Passports may be photographed.

Immigration papers.

Draft Registration Cards.

Selective Service Induction papers that bear any of the following Registrant’s information:

® N U

—  Earnings or Income.

—  Court Record.

—  Physical or mental condition.

—  Dependency Status.

—  Previous military service.

—  Exception: United States military discharge certificates may be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the
head of such department or bureau).

Reproducing the following is also prohibited in certain states:
e  Automobile Licenses.

e  Drivers’ Licenses.

e  Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case
of doubt, consult your attorney.

For more information about these provisions contact the Copyright Office, Library of Congress,
Washington, D.C. 20559. Ask for Circular R21.

Canada

Parliament, by stature, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

e  Current bank notes or current paper money

e  Obligations or securities of a government or bank

e  Exchequer bill paper or revenue paper

e The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of
a court of law

e  Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause
same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer
for a province)

e  Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a
province, the government of a state other than Canada or a department, board, Commission, or
agency established by the Government of Canada or of a province or of a government of a state
other than Canada

208 Xerox® WorkCentre® 3655 Multifunction Printer
User Guide



Regulatory Information

Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of
a province or by the government of a state other than Canada

Documents, registers, or records kept by public officials charged with the duty of making or issuing
certified copies thereof, where the copy falsely purports to be a certified copy thereof

Copyrighted material or trademarks of any manner or kind without the consent of the copyright or
trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is
assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be
imposed on those found guilty of making such reproductions.

Currency notes

Bank notes and checks

Bank and government bonds and securities

Passports and identification cards

Copyright material or trademarks without the consent of the owner
Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of
doubt, contact your legal counsel.
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Fax Requlations

United States

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device, including a fax machine, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity, or individual. The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested,
this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It connects to a compatible modular jack
that is also compliant. See installation instructions for details.

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation
instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be
connected to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing
in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0).
To be certain of the number of devices that can be connected to a line, as determined by the RENS,
contact the local Telephone Company. For products approved after July 23, 2001, the REN is part of the
product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN
without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately
shown on the label.
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To order the correct service from the local Telephone Company, you could also have to quote the codes
in the following list:

e  Facility Interface Code (FIC) = 02LS2
e  Service Order Code (SOC) = 9.0Y

/1 CAUTION: Ask your local Telephone Company for the modular jack type installed on your line.
Connecting this machine to an unauthorized jack can damage telephone company equipment. You,
not Xerox, assume all responsibility and/or liability for any damage caused by the connection of this
machine to an unauthorized jack.

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the
Telephone Company interrupts your service, they can advise you of your right to file a complaint with
the FCC if you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could
affect the operation of the equipment. If the Telephone Company changes something that affects the
operation of the equipment, they should notify you in order for you to make necessary modifications to
maintain uninterrupted service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for
repair or warranty information. Contact information is contained in the Machine Status menu on the
printer and in the back of the Troubleshooting section of the User Guide. If the equipment is causing
harm to the telephone network, the Telephone Company may request you to disconnect the equipment
until the problem is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make
repairs to the printer. This applies at any time during or after the service warranty period. If
unauthorized repair is performed, the remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state
tariffs. Contact the state public utility commission, public service commission, or corporation commission
for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that
the installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what could disable alarm equipment, consult your Telephone Company or a
qualified installer.
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Canada
This product meets the applicable Industry Canada technical specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or
alterations made by the user to this device, or device malfunctions, could cause the telecommunications
company to request you to disconnect the equipment.

For user protection, make sure that the printer is properly grounded. The electrical ground connections of
the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected
together. This precaution could be vital in rural areas.

& WARNING: Do not attempt to make such connections yourself. Contact the appropriate electric
inspection authority, or electrician, to make the ground connection.

The REN assigned to each terminal device provides an indication of the maximum number of terminals
allowed to be connected to a telephone interface. The termination on an interface could consist of any
combination of devices. The only limitation to the number of devices is the requirement that the sum of
the RENs of the devices does not exceed 5. For the Canadian REN value, please see the label on the
equipment.

European Union

Radio Equipment and Telecommunications Terminal Equipment Directive

The Facsimile has been approved in accordance with the Council Decision 1999/5/EC for pan-European
single terminal connection to the public switched telephone network (PSTN). However, due to differences
between the individual PSTNs provided in different countries, the approval does not give an
unconditional assurance of successful operation on every PSTN network terminal point.

In the event of a problem you should contact your authorized local dealer.

This product has been tested to and is compliant with ES 203 021-1, -2, -3, a specification for terminal
equipment for use on analog-switched telephone networks in the European Economic Area. This product
provides a user-adjustable setting of the country code. The country code should be set prior to
connecting this product to the network. Refer to the customer documentation for the procedure for
setting the country code.

Note: Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling, we
recommend that you set it to use DTMF signaling for more reliable and faster call setup.
Modification of this product, connection to external control software, or connection to an external
control apparatus not authorized by Xerox® will invalidate its certification.

South Africa

This modem must be used in conjunction with an approved surge protection device.
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Regulatory Information

New Zealand

1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has
accepted that the item complies with minimum conditions for connection to its network. It indicates
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not
imply that any Telepermitted product is compatible with all Telecom network services. Above all, it
provides no assurance that any item will work correctly in all respects with another item of
Telepermitted equipment of a different make or model.

The equipment may not be capable of correct operation at the higher data speeds designated.
33.6 kbpsand 56 kbps connections are likely to be restricted to lower bit rates when connected to
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such
circumstances.

2. Immediately disconnect this equipment should it become physically damaged, then arrange for its
disposal or repair.

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom
customers.

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is
no guarantee that Telecom lines will always continue to support pulse dialing.

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems,
do not contact the Telecom Faults Service.

6. DTMEF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is
readily available on almost all New Zealand telephone exchanges.

/1 WARNING: No 111" or other calls can be made from this device during a mains power failure.

7. This equipment may not provide for the effective hand-over of a call to another device connected
to the same line.

8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on
the equipment (computer) associated with this device. The associated equipment shall be set to
operate within the following limits for compliance with Telecom Specifications:

For repeat calls to the same number:

—  There shall be no more than 10 call attempts to the same number within any 30 minute period
for any single manual call initiation, and

—  The equipment shall go on-hook for a period of not less than 30 seconds between the end of
one attempt and the beginning of the next attempt.

For automatic calls to different numbers:

The equipment shall be set to ensure that automatic calls to different numbers are spaced such that

there is no less than five seconds between the end of one call attempt and the beginning of
another.

9. For correct operation, total of the RNs of all devices connected to a single line at any time should
not exceed five.
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Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:
e  North America: www.xerox.com/msds
e  European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
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Recycling and Disposal

This appendix includes:

e All Countries 216
e  North America 217
e  European Union 218
e  Other Countries..... 220
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Recycling and Disposal

All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead,
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental
considerations. The presence of these materials is fully consistent with global regulations applicable at
the time that the product was placed on the market. For recycling and disposal information, contact your
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing
devices, such as batteries. Special handling may apply, please see
www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Recycling and Disposal

North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information
about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal
information, contact your local authorities.
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Recycling and Disposal

European Union

Some equipment may be used in both a domestic/household and a professional/business application.

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you
should not dispose of the equipment in the normal household waste
stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to
designated collection facilities free of charge. Please contact your local disposal authority for
information.

In some member states, when you purchase new equipment, your local retailer may be required to take
back your old equipment free of charge. Please ask your retailer for information.

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you
must dispose of this equipment in compliance with agreed national
procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back
information.
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Recycling and Disposal

Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents
mean that used electrical and electronic products and batteries should
not be mixed with general household waste.

For proper treatment, recovery, and recycling of old products and used
batteries, please take them to applicable collection points, in
accordance with your national legislation and the Directive
2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to
save valuable resources and prevent any potential negative effects on
human health and the environment which could otherwise arise from

inappropriate waste handling.

For more information about collection and recycling of old products
and batteries, please contact your local municipality, your waste
disposal service or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in
accordance with national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for
further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact
your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical
symbol. This establishes compliance with the requirements set out by
the Directive.

Hg

Battery Removal

Batteries should only be replaced by a MANUFACTURER-approved service facility.
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Recycling and Disposal

Other Countries

Please contact your local waste management authority to request disposal guidance.
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